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COMcheck-EZ

You can use COMcheck-EZ™ to demonstrate that your commercial or high-rise
residential building design complies with the 2001 Edition of the International
Energy Conservation Code (IECC). COMcheck-EZ includes a software method
and a manual method for demonstrating compliance.

The COMcheck-EZ software provides a highly flexible way to demonstrate
compliance with minimal input. The envelope section allows tradeoffs between
envelope components, including roofs, walls, windows, floors, and skylights. The
lighting section enables you to quickly determine if your lighting design meets
interior-lighting power limits. The mechanical section enables you to assemble a
customized list of code requirements that are applicable to the systems and
equipment in your building.

Table Columns and Rows

You can delete, move, collapse, and expand the rows and columns in the tables.

Rows

To select a row, click on the leftmost column of that row (the column containing
row numbers). The row will be reversed (black background) when correctly
selected. You can also select multiple rows by clicking and holding down the left
mouse button on the left-hand column and dragging it over the desired rows.

Rows can be moved by:
1. selecting the row(s) to be moved (as described above),
2. releasing the mouse button,

3. clicking and holding down the mouse button on the leftmost column
of any of the selected rows (a small box will appear at the tail end of
the arrow cursor),

4. dragging the mouse to the new location-a thin red line will appear
indicating where the row(s) should be placed,

5. releasing the mouse button when the red line has been placed in the
desired location.

On the main screens, a single table row can also be moved by dragging the
corresponding row label in the tree located to the left of the table. Click the
mouse on the desired label and drag it to another label on the tree. After
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releasing the mouse, the dragged label (and row) will be positioned directly under
the label on which it was dropped. Some restrictions apply to the placement of
rows. In the Envelope screen, for example, window and door rows can be
placed only under exterior wall or basement wall rows. Skylight rows can be
placed only under roof rows.

On the main screens, you can collapse and expand rows by using the tree
located to the left of the table. Rows that fall below a "parent” row on the tree
can be collapsed so they are not displayed. For example, an exterior wall row
with several windows and doors under it can be collapsed to hide the windows
and doors. A tree label with a minus sign to the left of the label is already
expanded. It can be collapsed by clicking on the box containing the minus sign.
Tree labels that are already collapsed have a plus sign to the left of the label.
They can be expanded by clicking the box containing the plus sign. Clicking the
plus or minus sign to the left of the Building label will expand or collapse all rows
in the table.

Columns

You can move table columns by selecting a single column by clicking the left
mouse on the column heading. Select multiple columns by clicking and holding
down the left mouse and dragging it over the desired column headings. Selected
columns will be reversed (black background).

Columns can be moved by:
1. selecting the column(s) to be moved (as described above),
2. releasing the mouse button,

3. clicking and holding down the mouse button on the column heading
of any of the selected columns (a small box will appear at the tail
end of the arrow cursor),

4. dragging the mouse to the new location-a thin red line will appear
indicating where the column(s) should be placed,

5. releasing the mouse button when the red line has been placed in
the desired location.

Table column widths can be modified by moving the mouse over the right edge of
the corresponding column header until the mouse pointer changes to a double-
sided arrow until the mouse pointer changes to a double-sided arrow.

When the mouse pointer changes, drag the column to the desired width.
Columns that have been totally collapsed can be restored by double-clicking the



mouse on the column header separation (the vertical line in the top row
representing the hidden column).

File Menu

Use the File menu to open existing project data files (Open) and save your
project data (Save). The New option allows you to erase the current data and
begin a new project data file. The Save As option allows you to save your
current project data file to a new name. The program provides options for
previewing and printing compliance certificates, and for directing output to
selected printers (Print Report, Print Preview, and Print Setup, respectively). You
can also save the compliance certificate to a file in rich text format [rtf] (Save
Report) for inclusion in another document. An example building file is provided
with the software ("example.cck").

E example_cck - COMchec

Edit Wiew Options Lo
Mew Clrl+M E
Open... Ctrl+0 =
Save Clrl+5 |
Save Az .

Prnt Report...  Chl+P C
Frint Prexiew -
Print Setup...

Save Report. .

1 example.cck

E xit

Edit Menu

Use the Edit menu to cut, copy, paste, delete, and duplicate data in the tables.
You can also click the right mouse button on any field or tree label to display a
pop-up list with these same options (see Context Menu).

January 2004 3



example.cck - COMcheck-EZ

File | Edit ¥iew Options Coder |

& Cuk [Chrl+
—  Copy Ctil+C
Paste [Chrl+

Rc [Delete Bowlz] (e

[upheate Bowls] Ehill

]_ LI

The edit commands can be applied to individual table cells, to a selected table
row, or to multiple selected rows.

Cut

Use the Cut option to delete the highlighted text in a cell. You can paste the
deleted text into another cell of the same type.

Copy

Use the Copy option to copy the highlighted text in a cell. The copied text can be
pasted into another cell of the same type.

Paste

Use the Paste option to paste the last copied text into a selected cell. Note that
you can only paste cell data of the same type.

Delete Row(s)

Use the Delete Row(s) option to delete all selected rows. To select a row, click
on the tree label corresponding to that row or click on the leftmost column of that
row (the column containing row numbers). Multiple consecutive rows can be
selected by holding down the left mouse button on the left-hand column and
dragging it over the desired rows. Non-consecutive rows can be selected by
holding down the Ctrl key while clicking the leftmost column of each row to be
selected. You can also delete rows by selecting the corresponding icon from the
toolbar.

Duplicate Row(s)

Use the Duplicate Row(s) option to duplicate one or more consecutive selected
rows. To select a row, click on the tree label corresponding to that row or click
on the leftmost column of that row (the column containing row numbers).
Multiple consecutive rows can be selected by holding down the left mouse
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button on the left-hand column and dragging it over the desired rows. Non-
consecutive rows can be selected by holding down the Ctrl key while clicking the
leftmost column of each row to be selected. You can also duplicate rows by
selecting the corresponding icon from the toolbar.

View Menu
Use the View menu to view or hide software features.

ﬁexample.cck - COMcheck-EZL

File Edit RYEEN Options Code Help

Dlli’vl v Toolbar
————  Statuz Bar

Prﬂ]i Mandatory Requirements !
M Component Lizt [Mechanicall
o Bui Hequiretments List.[l'-r'lechanice.ul]

i |nzpection Checklist (Mechamical] B

Toolbar and Status Bar

The Toolbar and Status Bar options hide or display the Toolbar or Status Bar.

Mandatory Requirements

The Mandatory Requirements option displays requirements that must be met by
all buildings in addition to the requirements determined to be applicable by the
software. You may view and print separate mandatory requirements for
Envelope, Lighting, and Mechanical.

Component List (Mechanical)

The Component List option displays a table on the right side of the Mechanical
screen. The table contains all HVAC system, plant, and water heating
components you have created. The table also contains a column for entering the
guantity of each component.

Requirements List (Mechanical)

The Requirements List option displays a comprehensive description of
requirements applicable to the selected component or system. If you select the
Building label in the tree at the left of the screen, the list of requirements
applicable to all building systems is displayed. If you select a specific
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mechanical component label in the tree, the requirements applicable to only that
component are displayed.

Inspection Checklist (Mechanical)

The Inspection Checklist option is another way to view the lists of requirements.
This option displays the same lists of requirements as the Requirements List
option but in an abbreviated (checklist) format. Selecting the Building label in the
tree displays the list of requirements for the building. Selecting a specific
mechanical component label displays the requirements applicable to only that
component.

Options Menu

Use the Options menu to toggle optional software features on or off. All features
under the Options menu are optional--none are required to demonstrate
compliance.

ﬁ example cck - COMcheck-EZ

File Edit iew | Dptions Code Help

Ol = E Commentz/Descrption [Envelope]
Proiect i Orientation [Envelope]
roje Draylight Contral Factar [Envelope]
Roof |Skwi£ Swaces |Liattmg]

| Eremphiones and Al owanees [ Lattmg)

Comments/Description (Envelope)

Select this option to create a Comments/Description column on the Envelope
screen. Use the Comments/Description column to type additional information
about a building assembly that you wish to be included in the Inspection
Checklist, such as its location. The blank Comment lines provided in the
Inspection Checklist are replaced with any text entered in this column.

Orientation (Envelope)

Use the Orientation option to add a column to the Envelope screen to select
North, East, South, or West orientations for each exterior wall, window, door,
and basement wall assembly. If an orientation is selected for an assembly linked
to other assemblies (such as a window linked to an exterior wall), the orientation
for all of the linked assemblies is changed to match the new selection.



If an orientation has been assigned to each wall, window, door, and below-grade
wall assembly, the compliance calculation will be based on a proposed building
using those orientations. This result may be slightly different than the result
obtained when orientation is not specified. In the latter case, assemblies are
assumed to be equally distributed according to a code-specified aspect ratio. The
orientation-specific compliance calculation will not be performed until all
assemblies have been assigned an orientation.

Daylight Control Factor (Envelope)

If you select Daylight Control Factor, COMcheck-EZ adds two columns to the
Envelope screen--DLCF (daylight control factor) and VLT (visible light
transmittance). To receive credit for DLCFs, you must enter the DLCF for all
exterior wall, window , and door components; the VLT for each window; and the
orientation of each exterior wall, window, door, and basement wall assembly.

The Daylight Control Factor (DLCF) option offers modest credit toward envelope
compliance where automatic lighting controls for daylight use are used. To
activate this option, select Daylight Control Factor from the Options menu. When
this option is selected, two new columns are added to the table on the Envelope
screen. The VLT column is used to enter the visible light transmittance (VLT)
of windows. The DLCF column is used to enter the daylight control factor.

The DLCF is the fraction of the installed lighting power within 15 ft of the exterior
wall that will be automatically controlled for daylight use. The software accepts
values from 0.0 to 1.0. If the lights will not be controlled for daylight use, the
appropriate value to use is zero.

DLCF is an attribute of a daylit exterior zone, of which windows, the electric
lighting systems, and the daylight control systems are parts. Thus, whatever
DLCF value you enter applies uniformly to all components of the daylit zone,
which includes an exterior wall and all windows and doors that penetrate the wall.
Changing the DLCF for one of these components changes it for them all. To
calculate DLCF, sum the wattage of all electric lights in a 15-ft deep daylit zone
that runs the length of the exterior wall, then calculate the decimal fraction of that
wattage controlled by daylight sensors.

This feature of the code is intended to permit the use of higher window-wall ratios
and higher VLT glazings when used in conjunction with automatic lighting
controls for daylighting. Use of DLCF and VLT are only appropriate where such
controls are to be used.

The DLCF is dependent on orientation, so components must be entered using
the Orientation option if Daylight Control Factor is selected. If the Orientation

option was not previously selected, the software will automatically select it and
add the Orientation column to the table. If a DLCF is entered for an assembly
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linked to other assemblies (such as a window linked to an exterior wall), the
DLCEF for all linked assemblies is changed to match the new value.

Visible Light Transmittance (Envelope)

The VLT input column is displayed only after the DLCF option has been selected
from the Options menu and provides benefit only when used in conjunction with
DLCF. VLT is the decimal fraction of visible light that passes through the
window. The software accepts values from 0.0 to 1.0. See manufacturer's
literature for the correct value to use with your selected glazing product. For a
typical VLT value for the glazing characteristics you have selected, click with the
right mouse button on the VLT input field and select Use Typical. The Use
Typical feature provides values that can be used in preliminary evaluations
before actual product selections have been made.

Spaces (Lighting)

The Spaces option allows you to link lighting fixtures to spaces within the
building. The tree on the left side of the Lighting screen shows the linkage
between each space and the fixtures within it. The Spaces option is
recommended because it simplifies verification of fixture counts.

Exemptions and Allowances (Lighting)

To identify an exempt fixture, first make sure Exemptions and Allowances is
checked in the Options menu.

Exemptions

The 2001 IECC permits fixtures used for the following purposes to be treated as
exempt from inclusion in interior lighting power totals:

1. Special Medical/Dental/Research Lighting
2. Professional Sports Arena Playing Field Lighting
3. Gallery/Museum/Monument Exhibits

4. Lighting in Residential Dwelling Units - including guest room lighting
in hotels, motels, boarding houses, high-rise multifamily housing,
and similar buildings

5. Emergency Lighting (Automatic Control) — emergency lighting that is
automatically off during normal building operation



Allowances

To use the optional allowances feature, click the mouse on the Exemption
Allowance column of that fixture. A pop-up list will be displayed giving you a
choice of None, Exemption, or Allowance--select Allowance. A second pop-up
will list the allowances available for that fixture, and a third pop-up will list the
building use types that can be used for that allowance. The following allowances
may be claimed under the 2000 IECC code:

Decorative — qualifying lighting 1) must be for decorative purposes, 2) must be in
addition to general lighting, 3) must be controlled on separate circuits from
general lighting, and 4) the entered area must include only the floor area of the
space containing the decorative lighting.

Visual Display Terminals — qualifying lighting 1) must be installed to meet
requirements of visual display terminals (VDT) as the primary viewing task and 2)
for the entered area, must include only the floor area of the space containing the
VDT lighting.

Merchandise Display — qualifying lighting must be 1) installed to highlight specific
merchandise, 2) in addition to general lighting, 3) and controlled on separate
circuits from general lighting; the entered area must be the area of the specific
merchandise display and NOT the floor area of the space.

Fine Merchandise Display — qualifying lighting must be 1) installed to highlight
fine merchandise such as jewelry, fine apparel, and accessories or china and
silver, 2) in addition to general lighting, 3) and controlled on separate circuits
from general lighting; the entered area must be the area of the actual case or
shelf area for displaying and selling fine merchandise and NOT the floor area of
the space.

Emergency Medical/Pharmacy — qualifying lighting must be installed in spaces
designed for emergency, recovery, medical supply, or pharmacy.

Allowances are only available for certain whole building types and area category
types and can only be taken if one of these building types has already been
created on the Project screen. If none of the applicable building use types has
been created, the Allowance option will be disabled (gray). The following table
lists the building use types for which power allowances are permitted, the
applicable allowance type, and the maximum allowance in W/ft* that is applied by
the software.
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Whole Building |Area Category Allowance Type  |Allowance

Type (WIFt?)

\ \Bank/FinanciaI Institution \Decorative \1.0

Classroom/Lecture Hall Visual Display 0.35
Terminals

Convention, Conference or  |Decorative 1.0

Meeting Center

\ \Dining \Decorative \1.0

\Exercise Center \Exercise Center \Decorative \1.0

Grocery Store Grocery Store Merchandise 1.6
Display

\ \Hotel Function \Decorative \1.0

]Library \Library \Decorative \1.0

|- Lobby-Hotel Decorative 1.0

- Lobby-Other Decorative 1.0

Medical and Medical and Clinical Care  |Visual Display 0.35

Clinical Care Terminals

1.0

Emergency
Medical/Pharmacy

Museum Museum Visual Display 0.35
Terminals

Office Office Visual Display 0.35
Terminals

Religious Religious Worship Decorative 1.0

Worship

Restaurant Restaurant Decorative 1.0

Retail Sales, Retail Sales, Wholesale Merchandise 1.6

Wholesale Showroom Display

Showroom 3.9
Fine Merchandise
Display

Theaters- Theaters-Performance Decorative 1.0

Performance

After selecting the building use type, a dialog appears asking for the floor area
(ft%) that the allowance applies to. The software will not allow entry of a floor area
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larger than the floor area indicated on the Project screen for that building use
type. The software multiplies the allowance (listed in the third column of the table
above) by the square footage entered in this dialog to determine the amount of
additional wattage added directly to the Allowed Wattage total. This allowance,
however, cannot exceed the total proposed wattage of the fixture(s) (the Number
of Fixtures times the Fixture Wattage).

The selected allowance, building use type, and floor area are copied to the
Exemption Allowance field on the Lighting table. You can expand this field to
read the entire entry by dragging the right grid line of the Exemption Allowance
column header to the right.

Context Menu

Clicking the right mouse button on a tree label or table displays a pop-up list,
referred to as a context menu. The context menu options are applied to a single
field in a table or to an entire row in a table, depending on where the mouse is
clicked. If the mouse is clicked on a tree label, the menu options are applied to
the row corresponding to that label. If the mouse is clicked on the left field of a
row in a table, the options are applied to the entire row. Some options are
applicable to individual fields of a table, and the mouse must be clicked on the
given field to activate the option.

i Projecti
U-Factor | SHGC F; o
0.037

En 0.0 |
. Cut L
_ LComy 0
|| Paste 0
0

Elete Bt ]
[rpiEate Haw |

— Usze Typical I
— Edlit Tiext o
it | Fpits

Context Menu
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Cut, Copy, Paste, Delete Row(s), and Duplicate
Row(s)

The Cut, Copy, Paste, Delete Row(s), and Duplicate Row(s) options are
available from the Edit menu in the menu bar, from toolbar buttons, and from the
context menus. See the previous section on the Edit menu for a description of
these options. The Cut, Copy, and Paste options can be applied to individual
fields in a table. The Delete Row(s) and Duplicate Row(s) options are always
applied to an entire row or rows.

You cannot duplicate a row of one type and place it over a row of another type.
For example, you cannot duplicate a row in the Envelope table containing a roof
component and place it in a row already containing a window component--this
will generate an error message.

Use Typical

The Use Typical option enables you to enter a common value for products having
the characteristics you have selected. You can use this feature in initial
compliance checking before actual products have been selected. However,
products used in the building must meet or exceed the performance you assume
in the compliance analysis.

The Use Typical option places a common value into an individual field of a table.
For example, after selecting a window component and describing the glazing
and frame characteristics of that window, you can right-click the U-Factor column
of the window component and select the Use Typical option from the Context
menu. The software will supply a window U-factor that is "typical” for a window
with those characteristics. Select Use Typical by right-clicking on the SHGC
column or the VLT column (see VLT), and the software will provide a typical
solar heat gain coefficient (SHGC) value or a typical visible light
transmittance value for the window.

You can also right-click in the Fixture Wattage column on the Lighting screen;
then select Use Typical to have the software provide a typical fixture input
wattage, i.e., for the lamp/ballast combination.

Edit Text

The Edit Text option is used to edit the text on a tree label. When you create a
new envelope assembly or lighting fixture, a new row appears in the
corresponding table and a new tree label appears on the tree to the left. The tree
labels are assigned default names such as Roof 1 or Incandescent 2. These
labels can be changed by clicking the right mouse button on the label and
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selecting Edit Text from the Context menu. An edit box will become visible
where the label used to be, and you can rename the label by typing in the edit
box. Press Enter or click elsewhere when finished. You can enter a maximum
of 128 characters in the edit box. You can also edit tree labels by double-clicking
on the label.

Edit Inputs

The Edit Inputs option is only available on the Envelope screen when right-
clicking on a basement wall row or a slab row. On the Mechanical screen,
components are created using pop-up screens (called dialogs) or a series of
such screens (called a wizard). If you want to change any of the inputs for a
particular mechanical component, click the right mouse button on the tree label
for that component and select Edit System Inputs, Edit Plant Inputs, or Edit SWH
Inputs (the context menu option changes depending on which type of mechanical
component you have selected). The input screen(s) will be redisplayed with your
original inputs, which you can change.

Code Menu

Use the Code menu to select which code version you want the program to use
when determining compliance.

PZjuntitled - cOMcheck-E2

File Edit Wew Options | Code Help
0 | E’vl El ¥ | | v 90.1('39) Code

20,1 "33 Standard

Project | Env  90.1 (2001} Standard
1998 IECC
2000 TECC =
2001 TIECC
State  |NESEENEE
. - Colorado
City I.-i‘-.l:ulngtu:un Seplials
Building Use LELETEE
Massachusetts
& whale Building Minnesata
Mew ork
Whole Building Merrnonk
—_ o ' o W B T

Help Menu

The Help menu provides general information on how to use COMcheck-EZ. The
Help Topics option displays all of the Help topics within COMcheck-EZ. The
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About COMcheck-EZ option displays the program’s version number and release
date. If there is an internet connection, the Check for COMcheck Updates option
checks for the most current release of COMcheck available for download and
provides the user an option to download a newer version if available.

E] example cck - COMcheck-EZ CODE:

Fil== Edit “iew Option: Code | Help

D||&| 5 |m|e] | HeeTos
. About COMcheck-EZ. ..

Project Envelope

Check for COMcheck lpdates
Foof | Skylight | Ext. vWall | —_—
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Project Screen

The Project screen is used to provide the software with information such as: 1)
the location of the proposed building (state and city) and 2) the building use
category and area. You may also enter specific project information that identifies
and describes your project.

Location

COMcheck-EZ lists the available cities for each state. If your city is not listed,
choose the closest city with similar weather conditions or consult with your local
building department

New York: COMcheck-EZ lists the available counties for New York. If your
county is not listed, choose the closest county with similar weather conditions or
consult with your local building department.

Building Use

Use the Whole Building compliance method for buildings that entirely match one
of the available building types. Use the Area Category compliance method for
mixed-use buildings when detailed information about space usage is available.
For some projects, you may have a choice of which compliance method to use.

A list of building types or area categories is displayed when you click the left
mouse in the Whole Building Type or Area Category column of the Building Use
table. The Assembly, Hotel/Motel, and Multifamily options displayed in the
whole-building types list are only available for envelope compliance. To make
them available, you must select the Envelope and/or Mechanical Compliance
Only checkbox. If lighting compliance is to be determined for one of these
building types, you must use the area category method of compliance.

New York: When New York is the selected code, and Multifamily is chosen
under Building Use, a Heating System Type section is added to the screen.

Project Type

Select New Construction or Addition. The selection will be included on the
compliance report although the trade-off calculations remain the same for all
project types.

Additions are treated the same way as New Construction, ignoring the common
walls between the existing building and the addition. All new systems being
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added must be entered in the software and must comply with the requirements.
Existing systems simply extended into an addition do not have to be included.

Project Information

16

Project Name — Enter a name to identify a specific project.

Designer/Contractor — Use this field to enter contact information for the
designer/contractor.

Document Author — Enter contact information for the person completing
the compliance documentation.

Notes — Enter any additional information about the project



Envelope Screen

Use the blue-on-white buttons at the top of the Envelope screen to create a list of
building components present in your proposed design. Each component you
select is added to the building components displayed on the Envelope screen.
For each component, enter appropriate values for all fields with white
backgrounds. These fields may include the assembly type, gross area (or
perimeter), cavity R-value, continuous R-value, assembly U-factor, construction
details, SHGC, and/or projection factor. To view an example building
description, open the "example.cck" file.

Concrete slab-on-grade components require a perimeter entered in linear feet
(ft). All other components require an area entered in square feet (ft?). The cavity
R-value input is used for insulation placed between structural members, while the
continuous R-value input is used for insulation that is continuous across the
structure such as rigid-roof insulation or insulating wall sheathing.

After you have completed the description of each new component, the program
automatically updates the compliance results. The results are displayed at the
bottom of the screen in the Envelope box. If TBD (to be determined) is displayed
in this field, you have not filled in all necessary fields. To determine which data
are missing or invalid, look for fields with red-on-white text. In addition to
providing inputs for all red-on-white fields, you must select at least one building
use type and provide its area on the Project screen before the software can
determine compliance.

Roofs

Roofs include portions of the building envelope that are above conditioned
space and are horizontal or tilted at less than 60 degrees from horizontal.

Select the Roof button to add a roof component to the description of your design
on the Envelope screen. Enter each unique roof assembly as a separate
component. You can enter multiple roof elements sharing the same construction
as one component with appropriate total area.

Roof Types

e All-Wood Joist/Truss — wood frame roof structures in which insulation is
placed between structural roof members; e.g., batt or loose-fill insulation in
cathedral ceilings or attic spaces.

e Non-Wood Joist/Truss — metal frame roof structures in which insulation is
placed between structural roof members; e.g., steel bar joists or trusses
with metal webs having insulation below the roof deck.
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e Structural Slab — any roof structure in which the roof is insulated primarily
or exclusively using continuous rigid insulation above the roof deck.

e Metal Roof without Thermal Blocks — metal building roofs where roof
insulation is draped across metal structural members and metal roofing is
attached to the structural members without rigid insulating spacers.

e Metal Roof with Thermal Blocks — metal building roofs where roof
insulation is draped across metal structural members and rigid insulating
spaces are used between structural members and metal roofing. Because
the thermal performance of metal building components is sensitive to
assembly and fastener details, you may find it advantageous to enter
these assemblies using the Other category and U-factors from
manufacturers' literature.

o Other — roof assemblies that do not fit in one of the above five categories
(see Assembly U-Factor under Roof Software Inputs).

Roof Software Inputs
Gross Area

Enter the gross area of the roof component in the Gross Area field. The gross
roof area includes the area of all skylights that penetrate the roof. Skylights are
shown below the roof to which they belong on the tree control on the left side of
the Envelope screen. To change the linkage of a skylight to a roof assembly,
drag the skylight label on the tree to a new roof label and release the mouse. The
roof area should be measured along the insulated boundary between conditioned
and unconditioned space (e.g., along sloping rafters if the roof insulation
follows the slope of the roof).

Cavity Insulation R-Value

Enter the R-value of any insulation to be installed in the cavities between roof
structural members. All R-values should be rated R-values for insulation
materials only. These values are commonly printed on the materials. The
insulating values of other parts of the building assemblies (e.g., ceilings and air
films) are already accounted for by the software based on assembly type.

Continuous Insulation R-Value
Enter the R-value of any continuous roof insulation. Continuous insulation is
insulation that runs continuously over structural members and is free of

significant thermal bridging; one example is rigid foam insulation above the roof
deck. All R-values should be rated R-values for insulation materials. The

18



insulating values of other parts of the building assemblies (e.g., ceilings and air
films) are already accounted for by the software based on assembly type.

Assembly U-Factor

If you have selected the Other roof type, enter the overall U-factor of the roof
assembly, including exterior and interior air films. Do not include the finished
ceiling in the U-factor calculation if the space between ceiling and roof structure
is used as an HVAC plenum. Building departments may require supporting
documentation for assemblies entered using the Other roof category and U-
Factor field.

Skylights

Skylights are defined as any transparent or translucent section in a building roof,
which include glazing material (glass or plastic), frame, and curb. Glazing
having a slope less than 60 degrees from horizontal is considered a skylight,
while glazing having a slope greater than 60 degrees from horizontal is
considered a window.

Select the Skylight button to add a skylight component to the description of your
design on the Envelope screen. Enter each unique skylight assembly as a
separate component. You can enter multiple skylight elements having the same
characteristics as one component with the appropriate total area.

Skylight Software Inputs

The software prompts you to enter three skylight characteristics each time you
create a skylight component—frame type and glazing layers are entered in the
Assembly column, and glazing type is entered under the Construction Details
column. Specifying these skylight characteristics is helpful for inspection
purposes and enables the software to provide typical performance characteristics
(i.e., U-factor and SHGC) for various glazing options.

Gross Area

Enter the area of the entire skylight component in square feet measured parallel
to the skylight surface, including both the glazing material and frame. The rough
skylight opening provides an acceptable proxy for this skylight area.

Frame Type and Glazing Layers

The frame type and glazing layers are selected from a pop-up list accessed by
clicking the left mouse button in the Assembly field. For frame materials not
listed, use the frame type that is thermally most similar; e.g., use Wood for metal-
clad wood skylights. The glazing layers field enables you to identify the number
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of glazing layers in the skylight (i.e., single, double, or triple). Low-E coatings are
included in the list because the performance impact of low-emissivity films is
similar to that of additional glass layers.

Glazing Type

The Glazing field (under Construction Details) enables you to identify the type of
glass in the skylight (i.e., clear, tinted, or reflective). Use Reflective if the glass
has a reflective surface, even if the glass is also tinted.

U-Factor

Skylight U-factor is based on the entire assembly, including glazing, sash,
curbing, and other framing elements. Center-of-glass U-factors cannot be used.

U-factors for skylights must be tested and documented by the manufacturer in
accordance with the NFRC test procedure. If an NFRC U factor rating is
available for your skylight, you should use its BB-Size rating (i.e., 48 by 48 in.).

The COMcheck-EZ program includes a feature that enables you to insert a
typical U-factor for the skylight characteristics you have selected. To access this
feature, click the right mouse button on the U-factor input field and select Use
Typical. The Use Typical feature provides values you can use in preliminary
evaluations before selecting actual products. However, the actual ratings of
products put in place in the building must meet or exceed (i.e., be no higher than)
the values you assume in the compliance analysis. Most products on the market
will meet or exceed the performance levels provided by the Use Typical feature.

Solar Heat Gain Coefficient (SHGC)

The Solar Heat Gain Coefficient (SHGC) field enables you to specify the
glazing's effectiveness in rejecting solar heat gain. SHGC is part of a system for
rating glazing performance used by the National Fenestration Rating Council
(NFRC). SHGC is gradually replacing the older index, shading coefficient (SC), in
product literature and design standards. If you are using glass whose
performance is listed in terms of SC, you may convert to SHGC by multiplying
the SC value by 0.87. Although skylight SHGC is an important variable for
energy-efficient design, it is not important in this compliance procedure.
Deviations from the program's typical values for skylight SHGC are unlikely to
impact compliance.

Exterior Walls
Select the Ext. Wall button to add an exterior above-grade wall to the description

of your design on the Envelope screen. Each unique above-grade wall assembly
should be entered as a separate component, but multiple wall elements sharing
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the same construction and orientation (if used) may be entered as one
component with appropriate total area.

Exterior and Interior Wall Types

« Wood Frame, Any Spacing - wood frame walls of any stud depth or
spacing. The category is intended primarily for lightweight walls but may
also be used for walls with masonry veneers.

« Metal Frame, 16" o.c. - metal frame (stud) walls of any gauge or depth,
spaced 16" o.c. The category is intended primarily for lightweight walls but
may also be used for walls with masonry veneers.

e Metal Frame, 24" o.c. - metal frame (stud) walls of any gauge or depth,
spaced 24" o.c. The category is intended primarily for lightweight walls but
may also be used for walls with masonry veneers.

o Metal Wall Without Thermal Blocks - metal building walls where wall
insulation is draped across metal structural members and metal siding is
attached directly to the structural members without rigid insulating
spacers.

e Structural Masonry Wall - a wall construction category used with masonry,
precast, and poured-in-place concrete, and concrete masonry units. You
can select from six specific types of masonry wall.

e Solid Concrete or Masonry <= 8"- solid precast or poured-in-place
concrete, as well as concrete masonry units with grouted cells and
actual thickness of 8" or less.

e Solid Concrete or Masonry >8" - solid precast or poured-in-place
concrete, as well as concrete masonry units with grouted cells and
actual thickness >8".

e« CMU <= 8" with Empty Cells - concrete masonry units (CMUSs) with
at least 50% of the CMU cells free of grout and actual thickness of
8" or less.

e« CMU >8" with Empty Cells - CMUs with at least 50% of the CMU
cells free of grout and actual thickness >8".

« CMU <= 8" with Integral Insulation - CMUs with integral insulation

(e.g., perlite or rigid insulation inserts within the cells of the
concrete masonry units) and actual thickness of 8" or less.
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e« CMU >8" with Integral Insulation - CMUs with integral insulation
(e.g., perlite or rigid insulation inserts within the cells of the
concrete masonry units) and actual thickness >8".

e Other - wall assemblies that do not fit in any of the other above-grade wall
categories. You may also use the Other category if specific features of
your wall give it a significantly lower U-factor than the corresponding
generic wall type listed in the menu. See Assembly U-Factor under
Exterior and Interior Wall Software Inputs.

Warning Note for Integral Insulation

Integral Insulation means insulation placed within the voids of CMUs. Selecting
this wall type automatically gives you credit for integral insulation. Loose-fill
insulation, such as perlite or rigid foam inserts are typically used. The CMU with
Integral Insulation wall types assume loose-fill insulation. For walls with better
performing integral insulation, use the Other wall category.

Do not enter values for Cavity R-Value and Continuous R-Value unless you have
additional insulation attached to this CMU wall assembly. Alternatively, you may
enter CMU walls using the Other wall type, but be prepared to provide supporting
documentation for the U-factor that you are required to enter.

Do not confuse this Integral Insulation discussion with the "Integral” insulation
position input available in ASHRAE's ENVSTD program. COMcheck-EZ does
not provide an insulation position input but instead assumes an "integral” position
for any insulation in above-grade exterior walls, as opposed to assuming the
insulation is either on the interior or exterior of the wall. This fixed assumption
provides the most generous assessment of the benefits of high heat-capacity
walls that would have been available if COMcheck-EZ included a user-input for
insulation position.

Exterior and Interior Wall Software Inputs

Gross Area

Enter the gross area of the wall component in the Gross Area field. The gross
wall area includes the area of all windows and doors that penetrate the wall.
Windows and doors appear below the wall to which they belong on the left side
of the Envelope screen. To change the linkage of a window or door to a wall,
drag the window or door label on the tree to the wall label and release the
mouse. For interior walls, ignore all window and door assemblies that penetrate
the wall.
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Cavity Insulation R-Value

Enter the R-value of any insulation to be installed in the cavities between above-
grade wall structural members. All R-values should be rated R-values for
insulation materials, which are commonly printed on the materials. The
insulating values of other parts of the building assemblies (e.g., gypsum board
and air films) are already accounted for by the software based on assembly type.

Continuous Insulation R-Value

Enter the R-value of any continuous insulation in the above-grade wall.
Continuous insulation is insulation that is continuous over framing members or
furring strips and is free of significant thermal bridging. All R-values should be
rated R-values for insulation materials. The insulating values of other parts of the
building assemblies (e.g., gypsum board and air films) are already accounted for
by the software based on assembly type.

Assembly U-Factor

If you have selected the Other wall type option, enter the overall U-factor of the
above-grade wall assembly, including exterior and interior air films. Building
departments may require supporting documentation for assemblies entered using
the Other wall category and U-Factor field.

Furring Type

The Furring input field is displayed in the Construction Details column for
structural masonry (concrete) above-grade walls. The furring input enables you
to specify the type of furring material (if any) used on the wall. If the wall has no
furring, select None. If the wall assembly employs metallic furring strips, clips, or
framing members, select Metal; otherwise, select Wood.

The furring material is assumed to create some thermal bridging of the insulation
in the cavity between furring members, thereby reducing insulation effectiveness.

Heat Capacity

The Heat Capacity column is only displayed if an exterior wall or basement wall
is created and the Other assembly type is selected. Heat capacity is the amount
of heat (measured in Btus) necessary to raise the temperature of 1 ft* of wall 1°F.
Allowable values are 1 to 25 Btu/(ft* °F), although no additional credit is given for
heat capacity values >21.

Example heat capacities for common wall constructions are shown below:
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'Wall Description 'Heat Capacity
Typical wood- or steel-framed wall 2

2" brick face/framed wall 5

4" prick/framed wall 9

8" block w/empty cores |11

6" concrete wall 14

8" block wi/solid-filled cores 16

12" block 15-18

Solid concrete/masonry wall greater than 8" thick 118-25

To precisely calculate the heat capacity of a wall assembly, sum the products of
the thickness, density, and specific heat of each material layer. These properties
for many common building materials can be found in Chapter 24 of the 1997
ASHRAE Handbook of Fundamentals. Because the specific heats of most
building materials average around 0.2 Btu/(lb®°F), a good approximation of heat
capacity for any wall assembly can be determined by estimating the weight per
square foot of exterior wall surface and dividing by 5.

All COMcheck-EZ compliance calculations assume that any insulation in an
above-grade exterior wall (or above-grade portion of a below-grade wall
assembly) is integral with the thermal mass of the wall, as opposed to assuming
the insulation is either on the exterior or the interior of the wall. This fixed
assumption provides the most generous assessment of the benefits of high heat-
capacity walls that would have been available had COMcheck-EZ included an
insulation position input.

Entering Assemblies by Orientation

The software allows you to enter building components with or without considering
the component orientation (north, south, east, and west). Initially, the orientation
option is turned off. If you prefer to enter components based on their orientation,
select the Orientation option under the Options menu. The compliance
calculation will not be based on orientation-specific components until an
orientation has been assigned to each exterior wall, window, door, and basement
wall component.

If the orientation feature is not being used, you can group and list like
components as a single component. However, if you need more than one entry
of the same component (e.g. where two assemblies of the same type have
different insulation levels), you must create as many additional components as
required.
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Interior Walls

Select the Int. Wall button to add an interior above-grade wall to the description
of your design on the Envelope screen. Enter only interior walls separating
conditioned from unconditioned space; ignore all other interior walls. Wall
types for interior walls are the same as the wall types for exterior walls. The
software inputs are also the same.

Windows

Windows are defined as any transparent or translucent section in an exterior
building wall, including sliding-glass doors, patio doors, and glass blocks but
excluding glass entry doors (which are entered using the Door button). Windows
include glazing material (which may be glass or plastic), framing (mullions,
muntins, and dividers), external shading devices, internal shading devices, and
integral (between glass) shading devices. Glazing having a slope greater than
60 degrees from horizontal is considered a window, while glazing having a slope
less than 60 degrees from horizontal is considered a skylight.

Select the Window button to add a window component to the description of your
design on the Envelope screen. Enter each unique window assembly as a
separate component. You can enter multiple window elements having the same
characteristics as one component with an appropriate total area.

Window Software Inputs

The software prompts you to enter window characteristics each time you create a
window component—frame type and glazing layers are entered in the Assembly
column, and glazing type is entered under the Construction Details column.
Specifying these window characteristics is helpful for inspection purposes and
enables the software to provide typical performance characteristics (i.e., U-
factor, SHGC, and VLT) for various glazing options.

Gross Area

Enter the area of the entire window component in square feet (ft?) measured
parallel to the window surface, including both glazed materials and frame. The
rough window opening provides an acceptable proxy for this window area.
Frame Type and Glazing Layers

The frame type and glazing layers are selected from a pop-up list accessed by
clicking the left mouse button in the Assembly field. The frame type enables you

to identify the window frame material and hence characterize the thermal
conductivity of the frame. For frame materials not listed, use the frame type that
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is thermally most similar; e.g., use Wood for metal-clad wood windows. The
glazing layers enables you to identify the number of glazing layers in the
windows (i.e., single, double, or triple). Low-E coatings are included in the list
because the performance impact of low-emissivity films is similar to that of
additional glass layers.

Glazing Type

The Glazing field (under Construction Details) enables you to identify the type of
glass in the window (i.e., clear, tinted, or reflective). Use Reflective if the glass
has a reflective surface, even if the glass is also tinted.

U-Factor

Window U-factor is based on the entire assembly, including both glazing and
frame. Center-of-glass U-factors cannot be used. Glazing U-factors must be
tested and documented by the manufacturer in accordance with the National
Fenestration Rating Council (NFRC) test procedure. The COMcheck-EZ
software includes a feature that enables you to insert a typical U-factor for the
window characteristics you have selected. To access this feature, click the right
mouse button on the U-factor input field and select Use Typical. The Use Typical
feature provides values you can use in preliminary evaluations before selecting
actual products. However, the actual ratings of products in the building must
meet or exceed (i.e., be no higher than) the values you assume in the
compliance analysis. Most products on the market will meet or exceed the
performance levels provided by the Use Typical feature.

Solar Heat Gain Coefficient

The Solar Heat Gain Coefficient (SHGC) specifies the glazing's effectiveness in
rejecting solar heat gain. SHGC is part of a system for rating window
performance used by the NFRC. SHGC is gradually replacing the older index,
shading coefficient (SC), in product literature and design standards. If you are
using glass whose performance is listed in terms of SC, you may convert to
SHGC by multiplying the SC value by 0.87.

SHGCs must be tested and documented by the manufacturer in accordance with
the NFRC test procedure.

If interior blinds are to be used in the building and are documented in the contract
documents submitted as part of the permit application, you may account for them
in the SHGC value. However, their impact in lowering the effective SHGC must
be consistent with manufacturers' data, the ASHRAE Handbook of
Fundamentals, or another authoritative source. This credit cannot be used to
reduce a window's SHGC by more than 15%. For example, a window with a
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SHGC of 0.6 can receive a credit of at most 0.09, which would result in an
effective SHGC of 0.51.

Projection Factor

The projection factor enables you to characterize the shading impact of
horizontal overhangs or canopies that project outward from the plane of the
window. The projection factor is the ratio of the distance the overhang projects
from the window surface to its height above the sill of the window it shades. The
software accepts values from 0.0 to 1.0.

Entering Assemblies by Orientation

The software allows you to enter building components with or without considering
the component orientation (north, south, east, and west). Initially, the orientation
option is turned off. If you prefer to enter components based on their orientation,
select the Orientation option under the Options menu. The compliance
calculation will not be based on orientation-specific components until an
orientation has been assigned to each exterior wall, window, door, and
basement wall component.

If the orientation feature is not being used, you can group and list like
components as a single component. However, if you need more than one entry
of the same component (e.g. where two assemblies of the same type have
different insulation levels), you must create as many additional components as
required.

Daylight Control Factor

See Daylight Control Factor under Options Menu.
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Visible Light Transmittance

See Visible Light Transmittance under Options Menu.

Doors

Select the Door button to add a door component to the description of your design
on the Envelope screen. Enter each unique door assembly as a separate
component. You can enter multiple door elements sharing the same
characteristics as one component with the appropriate total area.

The Door button is intended for use with most types of commercial doors.
Sliding-glass doors and atrium doors that function primarily as windows rather
than to accommodate circulation (e.g., in multifamily or hotel/motel) should be
entered using the Window button and not the Door button. Doors located in
exterior walls and the walls of conditioned basements should be included, but
areas of doors separating conditioned from unconditioned space should be
included in the areas of the interior walls which they penetrate.

Door Types

o Solid (<=50% glazing) - exterior doors that are mostly opaque (i.e., glass
covers less than half of the door's area) and are intended to accommodate
occupant circulation.

e Glass (>50% glazing) - exterior doors that are mostly glazed (i.e., glass
covers more than half of the door's area) and are intended to
accommodate occupant circulation.

e Overhead - any large exterior doors designed to accommodate large
objects and/or vehicular circulation.

e Air Lock Entry - exterior doors arranged in pairs to limit infiltration
associated with occupant circulation.

e Revolving - revolving exterior doors such as those frequently used in
hotels and large retail establishments.

o Other - any exterior doors that do not fit in any of the other five door
categories. You must enter a U-factor and you should be prepared to
provide the building department with manufacturers' literature or
documentation of U-factor calculations.
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Door Software Inputs
Gross Area

Enter the total area of the door in square feet, including any glazed portions. The
rough opening for the door is an acceptable proxy for this door area.

U-Factor

Enter the overall U-factor for the door(s) from manufacturers' literature or select
the Use Typical option from the pop-up context menu accessed by clicking the
right mouse button in the U-Factor field. The Use Typical option provides a U-
factor for a door judged typical of the selected type containing little or no thermal
insulation.

Entering Assemblies by Orientation

The software allows you to enter building components with or without considering
the component orientation (north, south, east, and west). Initially, the orientation
option is turned off. If you prefer to enter components based on their orientation,
select the Orientation option under the Options menu. The compliance
calculation will not be based on orientation-specific components until an
orientation has been assigned to each exterior wall, window, door, and
basement wall component.

If the orientation feature is not being used, you can group and list like
components as a single component. However, if you need more than one entry
of the same component (e.g. where two assemblies of the same type have
different insulation levels), you must create as many additional components as
required.

Daylight Control Factor

See Daylight Control Factor under Options Menu.

Basement Walls

The basement wall component is intended for use with walls that are either
partially or fully below grade. Ignore portions of basement walls more than 10 ft
below grade. The COMcheck-EZ software automatically treats above-grade
portions of basement wall components like above-grade exterior walls.

Select the Basement button to add a basement wall component to the description
of your design on the Envelope screen. Enter each unique basement wall
assembly as a separate component. You can enter multiple basement wall
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elements sharing the same construction as one component with the appropriate
total area.

Basement Wall Types

e Solid Concrete or Masonry <= 8" - poured-in-place concrete walls and
concrete masonry units with grouted cells and actual thickness of 8" or
less.

e Solid Concrete or Masonry >8" - poured-in-place concrete walls and
concrete masonry units with grouted cells and actual thickness >8".

e CMU <= 8" with Empty Cells - concrete masonry units with at least 50% of
CMU cells free of grout and actual thickness of 8" or less.

« CMU >8" with Empty Cells - concrete masonry units with at least 50% of
CMU cells free of grout and actual thickness >8".

« CMU <= 8" with Integral Insulation - concrete masonry units with integral
insulation (e.g., perlite or rigid insulation inserts within the cells of the
concrete masonry units) and actual thickness of 8" or less.

o« CMU >8" with Integral Insulation - concrete masonry units with integral
insulation and actual thickness > 8".

e Other - wall assemblies that do not fit into any of the other basement wall
categories. You may also use the Other category if specific features of
your wall give it a significantly lower U-factor than the corresponding
generic basement wall type listed in the menu. See Assembly U-Factor
under Basement Wall Software Inputs.

Warning Note for Integral Insulation

Integral Insulation means insulation placed within the voids CMUs. Selecting this
wall type automatically gives you credit for integral insulation. Loose-fill
insulation, such as perlite or rigid foam inserts are typically used. The CMU with
Integral Insulation wall types assume loose-fill insulation. For walls with better
performing integral insulation, use the Other wall category. Alternatively, you
may enter CMU walls using the Other wall type, but be prepared to provide
supporting documentation for the U-factor that you are required to enter.

Basement Wall Software Inputs
Gross Area

Enter the gross area of the basement wall component in the Gross Area or
Perimeter column. The gross wall area includes the area of both above-grade
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and below-grade portions of the basement wall, and all windows and doors that
penetrate the wall. Windows and doors appear below the wall to which they
belong on the tree on the left side of the Envelope screen. To change the
linkage of a window or door to a basement wall, drag the window or door label
on the tree to the basement wall label and release the mouse.

Windows and Doors in Basement Walls

When windows and doors are added to basement walls, net opaque wall areas
are determined by subtracting windows and doors from any above-grade part of
the basement wall. If necessary, the above-grade portion of the basement wall is
increased so that windows and doors belong to the above-grade part of the
basement wall. See Wall Height and Depth Below Grade Help topics for an
explanation of how basement walls are treated with respect to being above or
below grade.

Cavity Insulation R-Value

Enter the R-value of any insulation to be installed in the cavities between furring
strips. All R-values should be rated R-values for insulation materials, which are
commonly printed on the materials. The insulating values of other parts of the
building assemblies (e.g., masonry and air films) are already accounted for by
the software based on assembly type.

Continuous Insulation R-Value

Enter the R-value of any continuous insulation to be installed either on the
inside or the outside of the basement wall. Continuous insulation is insulation
that runs continuously and is free of significant thermal bridging. All R-values
should be rated R-values for insulation materials. The insulating values of other
parts of the building assemblies (e.g., masonry and air films) are already
accounted for by the software based on assembly type.

Assembly U-Factor

If you have selected the Other basement wall type option, you must enter the
overall U-factor of the basement wall assembly, including the interior air film but
excluding the effects of earth and exterior air films. Building departments may
require supporting documentation for assemblies entered using the Other
basement wall category and U-Factor field.

Wall Height

Enter the average height of the basement wall measured from the top of the
basement floor to the top of the basement wall.
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The Wall Height (ft) and Depth Below Grade (ft) fields together enable you to
enter a basement wall assembly partially above and partially below grade as a
single entry. If the values in these two fields are the same, the wall will be
treated as entirely below grade.

Depth Below Grade

Enter the average depth below grade of the wall in the Depth Below Grade (ft)
field, measuring from the average grade level to the top of the basement floor.

Furring Type

The Furring input field (under Construction Details) enables you to specify the
type of furring material (if any) used on the wall. If the wall has no furring, select
None. If the wall assembly employs metallic furring strips, clips, or framing
members, select Metal; otherwise, select Wood.

The furring material is assumed to create some thermal bridging of the insulation
in the cavity between furring members, thereby reducing insulation effectiveness.

Entering Assemblies by Orientation

The software allows you to enter building components with or without considering
the component orientation (north, south, east, and west). Initially, the orientation
option is turned off. If you prefer to enter components based on their orientation,
select the Orientation option under the Options menu. The compliance
calculation will not be based on orientation-specific components until an
orientation has been assigned to each exterior wall, window, door, and basement
wall component.

If the orientation feature is not being used, you can group and list like
components as a single component. However, if you need more than one entry
of the same component (e.g. where two assemblies of the same type have
different insulation levels), you must create as many additional components as
required.

Floors

Select the Floor button to add a floor component to the description of your
design on the Envelope screen. Enter each unique exposed floor assembly as a
separate component. You can enter multiple floor elements sharing the same
construction as one component with the appropriate total area.

The Floor button is used to enter floors over unconditioned space, including
floors exposed to exterior conditions, floors over crawl spaces, floors over
unconditioned parking garages, and slab-on-grade floors. Interior floors that do
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not separate conditioned from unconditioned space are not included. Ignore
slabs more than 2 ft. below grade.

Floor Types

e All-Wood Joist/Truss - any structural wood floor in which insulation is
placed between the structural members; e.g., batt insulation between
wood floor joists.

e Nonwood Joist/Truss - any floor in which insulation is placed between
nonwood structural members; e.g., batt insulation between steel bar joists
or trusses with metal webs.

e Concrete Floor (over unconditioned space) — a poured-in-place concrete
floor over unconditioned space (e.g., concrete floor over an unconditioned
parking garage).

e Slab-On-Grade — concrete slabs whose perimeters are exposed to
exterior conditions.

e Other - floor assemblies that do not fit in any of the other three categories.
See Assembly U-Factor under Floor Software Inputs.

Floor Software Inputs
Gross Area or Slab Perimeter

Enter the gross area of the floor (in square feet) along the boundary where it
separates conditioned from unconditioned space or enter the perimeter of the
slab-on-grade component in linear feet.

Cavity Insulation R-Value

Enter the R-value of any insulation to be installed in the cavities between floor
structural members. All R-values should be rated R-values for insulation
materials, which are commonly printed on the materials. The insulating values of
other parts of the building assemblies (e.g., subfloor and air films) are already
accounted for by the software.

Continuous Insulation R-Value
Enter the R-value of any continuous floor insulation. Continuous insulation is
insulation that runs continuously over structural members and is free of

significant thermal bridging. All R-values should be rated R-values for insulation
materials. The insulating values of other parts of the building assemblies (e.g.,
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subfloor and air films) are already accounted for by the software. For slabs,
enter the R-value of the slab perimeter insulation.

Assembly U-Factor

If you have selected the Other floor type option, you must enter the overall U-
factor of the floor assembly, including exterior and interior air films. Building
departments may require supporting documentation for assemblies entered using
the Other floor category and U-Factor field.

Slab Type

The slab type is selected from a pop-up list accessed by clicking the left mouse
button in the Assembly field. The slab type enables you to specify whether the
concrete slab is heated or unheated. A heated slab (e.g., radiant slab) is one
designed as part of a space-conditioning system for transmitting heating into the
space. Heated slabs have higher insulation requirements than unheated slabs
under the code.

Insulation Position and Depth for Slab-On-Grade

The insulation position pop-up list enables you to specify if perimeter slab
insulation will be used and, if so, if it will be placed vertically or horizontally. If no
perimeter insulation will be used, select No Insulation.

The Insulation field (under Construction Details) enables you to specify the depth
of the insulation. The insulation must extend downward from the top of the slab,
or downward to at least the bottom of the slab and then horizontally to the interior
or exterior. Where slab insulation is required, it must fully insulate the slab edge
and extend from the top of the slab to the depth you select.

Horizontal Insulation Option: Horizontal insulation extending away from the
foundation must be covered by pavement or at least 10 in. of soil. If placed
horizontally, insulation depth is the total vertical plus horizontal distance. Five
options are available for horizontal insulation depth: 1, 2", 3', 4', and Continuous.
Select Continuous if the insulation will run under the entire slab.

Vertical Insulation Option: Insulation that is placed vertically, insulation depth is
measured from the top of the slab downward. Four options are available for
vertical insulation depth: 1', 2', 3, and 4.
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Lighting Screen

Use the blue-on-white buttons at the top of the Lighting screen to create a list of
lighting fixtures present in your proposed design. Each fixture type you select is
added to the lighting fixtures list displayed on the Lighting screen. For each
fixture type, you must enter a ballast type (if applicable), the number of lamps
per fixture, quantity, and the fixture input wattage. Input wattage is the electrical
power input to the lamp and ballast combination.

After entering complete information for each new fixture, the software
automatically updates the compliance results. The results are displayed at the
bottom of the screen in the Lighting: box. If TBD (to be determined) is displayed
in this field, you most likely have not yet filled in the fixture wattage or quantity for
one or more components. To determine which data are missing or invalid, look
for fields with red-on-white text. In addition to providing inputs for all red-on-white
fields, you must select at least one building use type and its corresponding area
on the Project screen before the software can determine compliance.

Optional features available on the Lighting screen may be selected from the
Options menu: Spaces (Lighting) and Exemptions and Allowances (Lighting).

T8/T12 Fluorescent

Select the T8 / T12 Fluorescent button to add fixtures using T8, T10, or T12
tubes to your list of fixtures on the Lighting screen.

Because of space limitations, lighting types are shown on the menus and main
screen using abbreviations. For example, 48" T12 ES 34W stands for a fixture
using 48" T-12 energy-saving fluorescent lamps rated at 34 watts each. The
following abbreviations are used in these descriptions:

« ES - energy saving, a designation that usually indicates the lamp will draw
10% to 15% less power than a standard lamp of the same type

e Slim - slimline, a type of fluorescent lamp that uses single-pin contacts
rather than the normal two-pin contacts

« T8 - a designation for tubular fluorescent lamps that are 1” in diameter

e T10 — a designation for tubular fluorescent lamps that are 1-1/4" in
diameter

e T12 — a designation for tubular fluorescent lamps that are 1-1/2” in
diameter

e U —U-shaped lamps

January 2004 35



« W —nominal lamp wattage. Note that this is not the fixture wattage that is
entered in the Fixture Wattage field. The fixture wattage must include
ballast energy and will generally be higher than this value.

Compact Fluorescent

Select the Compact Fluor. button to add compact fluorescent fixtures to your list
of fixtures on the Lighting screen.

Because of space limitations, lighting types are shown on the menus and main
screen using abbreviations. For example, Twin Tube 13W stands for a fixture
using compact fluorescent lamps rated at 13 watts each. The following
abbreviations are used in the descriptions:

e Twin, Triple, Quad — designation referring to the number of fluorescent
tubes projecting from the lamp (i.e., two, three, or four)

e 2-pin, 4-pin — designation referring to the number of contacts at the base
of the lamp

« W —nominal lamp wattage. Note that this is not the fixture wattage that is
entered in the Fixture Wattage field. The fixture wattage must include
ballast energy and will generally be higher than this value.

HID

Select the HID button to add fixtures using high-intensity discharge (HID) lamps
to your list of fixtures on the Lighting screen.

Incandescent

Select the Incandescent button to add fixtures using incandescent lamps to your
list of fixtures on the Lighting screen.

Spaces

The Lighting screen contains an optional feature that enables you to organize
lighting fixtures under the spaces (or parts of the building) in which they are used.
To activate this feature, select Spaces from the Options menu while in the
Lighting screen. This feature helps ensure fixture counts are correct and greatly
facilitates plan review and inspections.

To add spaces to your list of lighting fixtures on the Lighting screen, click on the
blue-on-white Add Space button (to the right of the fixture type buttons) at the top
of the Lighting screen. A new line will be entered on the main portion of the
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Lighting screen and a new space label will appear in the tree control at the left of
the screen. Fixtures listed below each space "belong" to that space and are
listed that way on the compliance certificate. You can change the space name
from the default name given by the software, which appears in the left-most table
column. To reorganize fixtures under these space names, simply drag the fixture
labels on the tree control.

Lighting Screen Inputs

Fixture ID

The Fixture ID field shows the fixture ID you have entered. You can associate
the fixture with a fixture type designation used on the lighting fixture schedule
and elsewhere in the construction documents; e.g., F1 for fixture type 1. Fixture
ID is an optional field that you may leave blank, but it is recommended as it
enables fixtures to be clearly defined.

Fixture Description

The Fixture Description field is for descriptions of fixtures that you enter. Fixture
Description is an optional field that you may leave blank. However, fixture
descriptions can help you keep track of the fixtures in the list, avoid errors and
oversights, and facilitate plan review and inspections because this information is
included on the compliance certificate. Fixture descriptions may include
manufacturer and part number, dimensions (e.g., 2x4), mounting type (e.g.,
recessed, surface, suspended), or other distinguishing characteristics.

Lamp Description/Wattage Per Lamp

Click the left mouse button in the Lamp Description/Wattage Per Lamp field to
select from a pop-up list of available lamp types. The pop-up list contains the
most commonly used lamp and ballast combinations. Select Other if the lamp
type you intend to use does not match one of the listed types. The Lamp
Description/Wattage Per Lamp is not a user-editable field unless you have
selected Other from the pop-up list.

Ballast

The ballast type is entered by selecting from a pop-up list. (Incandescent fixtures
do not require a ballast entry.) Available ballast types are magnetic, electronic,
and hybrid. The following definitions have been used in determining default input
wattages. You should use these definitions in describing the ballast type in the
fixtures you intend to use.
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e Magnetic — contains conventional capacitor, rectifier, and/or transformer
components (core and coil), and operates at a 60 Hz frequency.

o Electronic — contains advanced electronic components and no (or very
small) core and coil transformers, and operates at high frequency-typically
20,000 Hz or more.

« Hybrid — may contain both conventional components and electronic
circuitry. Use hybrid for any ballast that does not completely fit the
definition for either magnetic ballasts or electronic ballasts.

Lamps Per Fixture
The Lamps Per Fixture is entered by selecting from a pop-up list.
Number of Fixtures

The number of fixtures is entered by selecting from a pop-up list.

Fixture Wattage

You can enter the fixture wattage directly or have the software provide a typical
wattage for that fixture. To input a typical wattage, click the right mouse button in
the Fixture Wattage field to display the pop-up context menu. The software will
provide a typical input wattage for the fixture. Not all possible lamp and ballast
combinations are included-only those for which adequate data were available.
No values are provided for fixtures with hybrid ballasts, because the category
includes equipment of highly variable design. If the Use Typical option is gray, a
typical wattage is not available. Input wattage is the related electrical power
input to the lamp and ballast combination.

You may either use the typical input wattage provided by the software or override
it with a value based on the equipment you intend to install. In either case, you
should be prepared to provide supporting documentation based on
manufacturer's literature to the building department.
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Mechanical Screen

Use the blue-on-white buttons at the top of the Mechanical screen to enter
characteristics of HVYAC system, plant, and water heating components in your
proposed design. Because most requirements in the mechanical section of the
energy code are mandatory, the Mechanical section of the software works
somewhat differently from the Envelope and Lighting sections. Rather than
generating a numerical compliance index, the Mechanical section generates a
customized list of mandatory requirements applicable to the mechanical
components you identify. Click the Plant button or Water Heating button to
display a single screen on which you enter information about these components.
Click the HVAC System button to launch a series of screens (collectively
referred to as a wizard) on which you enter information about your building’s
HVAC components. The HVAC system wizard screen sequences depend on the
information you enter. You must continue to the final screen in the sequence
before the Finish button becomes active, enabling you to return to the
Mechanical screen.

After you click the Finish button on any of the screens, the software supplies a
default component name (in the left-hand screen), along with a corresponding
guantity and description (in the right-hand screen) for the component you
defined. You can edit the default component description or quantity by simply
clicking on the appropriate field and typing a new description or quantity. For
clarity and consistency with building plans, it may also be helpful to edit the tree
labels in the left-hand screen. To change these default names, double-click on
the name in the left-hand screen to bring up an edit box for the text.

Alternatively, you can right-click on the name to display a pop-up list (called a
context menu) and select Edit Text from this menu. Selecting Edit System
Inputs, Edit Plant Inputs, or Edit SWH Inputs from the context menu enables you
to redisplay the input screens for the given component and to redefine the
component inputs. You may also delete (cut), copy and paste, or duplicate
components by selecting the corresponding option from the context menu. For
more information on context menus, refer to the Help section Context Menu.

Viewing Mechanical Requirements

To view the requirements that apply to a mechanical component, select the
component, then go to the View menu and click the Requirements List or
Inspection Checklist option. The Requirements List option displays a
comprehensive description of requirements applicable to the selected
component. The Inspection Checklist option displays the same requirements,
but in an abbreviated (checklist) format. You can use the View menu to toggle
the display back to the list of mechanical components or to the detailed or
concise list of requirements. The output certificate will contain all three views:
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the list of your selected mechanical components, the checklist of requirements,
and the more detailed description of these same requirements.
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While in the Requirements List or Inspection Checklist view, click the Building
label on the left-hand screen to display mechanical requirements that apply to all
applicable building systems, independent of particular components selected.
Even though these requirements apply to all applicable systems, the same list of
requirements may not always be displayed. For example, there are duct
insulation and construction requirements that apply to all systems that have
ducts. Rather than repeat these same requirements for each ducted system in
the building, the requirements are printed once as generic requirements and are
displayed when the Building label is selected. However, if you have not selected
any systems having ducts, the requirements will not be displayed. Other
requirements will always appear. You can also find a description of the generic
requirements by selecting Mandatory Requirements from the View menu.

To view an example description of mechanical components, load the EXAMPLE
file from the File menu and click the Mechanical screen. To view the Mechanical
Compliance Certificate from within the software, select Print Preview from the
File menu. The checklist portion of the compliance certificate is intended for use
by building department staff during plan review and site inspection to ensure that
applicable requirements have been met.
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HVAC System Screens

The HVAC System button launches a sequence of screens to help you identify
key characteristics of the HVAC systems in your building. The term HVAC
systems refers to secondary HVAC systems, including controls, fans, terminal
boxes, radiators, coils, and package HVAC equipment, not primary HVAC
system components such as boilers, chillers, cooling towers, and pumps. The
characteristics you select determine which requirements apply.

The HVAC System screens enable you to describe the HVAC system features in
your building in sufficient detail to exclude large numbers of requirements that do
not apply to your systems. The resulting simplification facilitates both designing
for compliance with the code and code enforcement.

Round buttons (radio buttons) permit only one selection from each group, square
boxes (checkboxes) permit multiple selections from a group of inputs, and gray
text indicates that the option is unavailable because it is incompatible with other
selection(s) that have been made on the current or a previous screen.

When multiple different HVAC systems are used within a single building, you
may select the HVAC System button multiple times to enter more than one
system. When multiple identical (or nearly identical) systems are used, describe
them once and use the quantity field to indicate the number of such systems
present.

Equipment Type Selection Screen

The Equipment Type Selection screen is the first in a series of screens that
enable you to enter characteristics of the HVAC system(s) in your proposed
design. Select the Heating Equipment Type, Cooling Equipment Type, and
Zoning Category for the system(s) you are entering.

Note that some of the input fields are interdependent. If you select Heat Pump
as the Heating Equipment Type, you will not be able to select a Cooling
Equipment Type because it is assumed to be DX (direct expansion). If you
select Unit Heater for Heating Equipment Type or Packaged Terminal DX Unit for
Cooling Equipment Type, you will not be able to select Multiple-Zone or check
the Perimeter System box under Zoning Category because these equipment
types are not compatible.

After entering all your selections on the Equipment Type Selection screen, click

the Next button to proceed to the next screen and continue describing the
mechanical system.
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Heating Equipment Type

Central Furnace - A central furnace is a self-contained, indirect-fired or
electrically heated furnace supplying heated air through ducts to spaces. A
central furnace can be a stand-alone unit, but is typically integral to a rooftop-DX
(direct expansion) system or split DX system air conditioner. Though less
common, a central furnace may also contain a hydronic coil that would be used
for air conditioning.

Duct Furnace - A duct furnace is a furnace normally installed in distribution ducts
of air-conditioning systems to supply warm air. A duct furnace usually does not
have its own supply fan and uses air supplied through the ducts by other supply
fans such as a fan for a central air conditioner.

Hydronic or Steam Coil - A hydronic coil is an array of tubing, placed in a supply
air stream, through which hot or cold water passes, heating or cooling the supply
air stream to provide heating or air conditioning to a space. Hydronic coils,
central furnaces, and DX coils are used in various configurations of heating and
air- conditioning systems. A steam coil is an array of tubing, placed in a supply
air stream, through which steam passes to provide heat to a space.

Heat Pump - A heat pump is a DX air conditioner with a reversing valve, allowing
it to operate in two refrigeration modes. When the refrigeration system is
reversed, the heat pump absorbs heat from the outdoor air and rejects it to the
indoor environment, providing heat to the space. Heat pumps are manufactured
in several configurations, including packaged terminal, rooftop package, split
system, water loop, and ground coupled.

Radiant Heater - A radiant heater is a heater that transfers heat to objects and
surfaces within the heated space primarily (>50%) by infrared radiation. Radiant
heaters can be direct- or indirect-fired with a heating fuel, have electric heating
elements, or use hydronic coils or steam coils.

Unit Heater - A unit heater is a self-contained piece of heating equipment that
requires connections only to energy sources. Unit heaters are installed in the
spaces they are intended to heat and do not use ductwork to distribute heat.
They are sometimes controlled in sequence with a separate air conditioner
serving the same space. Unit heaters can be direct- or indirect-fired with a
heating fuel, have electric heating elements, or use hydronic coils or steam coils.

Other — any other type not represented in the above choices.
Cooling Equipment Type

Field Assembled DX System — This type is used for DX systems that are not
manufactured (and rated) as single packages but rather are assembled at the
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building site from separately manufactured components. DX stands for direct
expansion cooling. In DX cooling equipment, a refrigerant coil is placed directly
in the supply air stream. As the refrigerant evaporates and expands, it removes
energy, lowering the temperature of the supply air stream.

Hydronic Coil - A hydronic coil is an array of tubing, placed in a supply air stream,
through which hot or cold water passes, heating or cooling the supply air stream
to provide heating or air conditioning to a space. Hydronic coils, central
furnaces, and DX coils are used in various configurations of heating and air-
conditioning systems.

Packaged Terminal DX Unit — A packaged terminal DX air conditioner (PTAC) is
a self-contained air-conditioning unit typically installed through a wall. It
discharges cool air directly to the space without the use of ducts for distribution.
PTACs are often equipped with electric resistance heating elements and
sometimes are equipped with hydronic coils or steam coils for heating.

Rooftop Packaged DX Unit — A rooftop packaged DX unit is also known as a
unitary single-packaged air conditioner. This unit is a self-contained DX air
conditioner, typically installed on the roof of a building using ducts to distribute
cool air to the conditioned space. It can be used in single-zone or multiple-zone
applications, and can also be equipped with a constant-volume or variable-
volume fan. These units are often combined, within the same assembly, with a
central furnace, hydronic coils, or steam coils. Depending on the cooling
capacity and climate, rooftop packaged DX units may often be equipped with an
air economizer.

Split DX System — A split DX system is also known as a unitary split system air
conditioner or split system. It consists of two factory-made assemblies: a
condensing unit that uses outside air as the heat sink, and an indoor DX coil with
integral supply fan. The indoor unit is often combined, within the same
assembly, with a central furnace or hydronic coils or steam coils. Because the
indoor unit is usually located a long distance from outside walls, it is difficult to
equip a split system with an air economizer.

Other — any other type not represented in the above choices.
Zoning Category

Single Zone — A single-zone system serves only one thermostatic control zone.
The system is usually controlled by a single thermostatic control, and only
maintains comfort conditions for the space where the temperature control is
located.

Multiple-Zone — A multiple-zone system is designed to meet space-conditioning
loads in multiple thermostatic control zones at the same time. Multiple-zone
systems usually use a common air distribution system and employ terminal units
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to vary the flow and temperature of air to meet the differing space-conditioning
loads of each zone.

Perimeter System — A perimeter system is designed to offset only envelope heat
losses and gains.

Heating Equipment Details Screen

The Heating Equipment Details screen is the second in a series of screens that
enables you to enter characteristics of the HVAC systems in your proposed
design. This screen will appear if you have selected any heating equipment other
than Heat Pump in the Equipment Type Selection screen.

Select the Fuel Type or the Heat Source for the heating equipment. If you select
Hydronic or Steam Coil as the Heating Equipment Type, all selections for Fuel
Type will be disabled and you instead must select the Heat Source for this
equipment. If you select Central Furnace or Duct Furnace, all selections for Heat
Source will be disabled. If you select Radiant Heater or Unit Heater, you may
choose from either the Fuel Type or Heat Source options.

When you have finished your selections on the Heating Equipment Details
screen, click the Next button to proceed to the next screen and continue
describing the mechanical system, or click the Finish button to accept all of the
inputs and return to the Mechanical screen. If additional screens must be
completed, the Next button will be enabled (black text) and the Finish button will
be disabled (gray text). If there are no additional screens, the Next button will be
disabled and the Finish button will be enabled. You may cancel the sequence of
selections you have made at any time by pressing the Esc (escape) key.

Heat Pump Details Screen

The Heat Pump Details screen will be the second in a series of screens that
enable you to enter characteristics of the HVAC systems in your proposed
design. This screen will appear if you have selected Heat Pump as the Heating
Equipment Type in the first screen. Select the Heat Pump Type, Condenser
Type and Capacity. Note that Water-Cooled is the only condenser option
available if Water Loop Heat Pump is selected as the Heat Pump Type.

When you have finished your selections on the Heat Pump Details screen, click
the Next button to proceed to the next screen or click the Finish button to accept
all of the inputs and return to the Mechanical screen. You may cancel the
sequence of selections you have made at any time by pressing the Esc (escape)
key.
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Heat Pump Type

Packaged Terminal Unit — A packaged terminal heat pump (PTHP) is a self-
contained heat pump typically installed through a wall. It discharges warm or
cool air directly to the space without the use of ducts for distribution.

Rooftop Packaged Unit — A rooftop packaged heat pump is also known as a
unitary single-packaged heat pump. This unit is a self-contained heat pump,
typically installed on the roof of a building using ducts to distribute cool air to the
conditioned space . It can be used in single-zone and multiple-zone applications,
and can also be equipped with a constant-volume or variable-volume fan.
Depending on the cooling capacity and climate, rooftop packaged DX units may
be equipped with an air economizer.

Split System — A split system heat pump is also known as a unitary split system
heat pump. It consists of two factory-made assemblies: a condensing unit that
uses outside air as the heat sink (during cooling) and heat source (during
heating), and an indoor DX coil with integral supply fan. Because the indoor unit
is usually located a long distance from outside walls, it is difficult to equip a split
system with an air economizer.

Water Loop Heat Pump — A water loop heat pump is a heat pump with a
refrigerant-to-water heat exchanger. During cooling mode, the heat exchanger
serves as the condenser, rejecting heat from the refrigerant to the water. During
heating, the heat exchanger serves as the evaporator, absorbing heat from the
water. The refrigerant-to-water heat exchanger is typically connected to a
circulating water loop that also serves many other water loop heat pumps. A
boiler and cooling tower maintain the temperature range of the circulating water
loop. The boiler turns on when the temperature falls below the setpoint. The
cooling tower turns on when the temperature rises above the setpoint.

Other — Any type of heat pump, which is not described by one of the types listed
above, is classified as Other.

Condenser Type

The condenser of an air conditioner is where refrigerant rejects heat absorbed
during the process of cooling indoor spaces. As the refrigerant passes through
the heat exchanger it rejects heat to the surrounding fluid, usually air or water. If
the equipment is a heat pump, the condenser becomes an evaporator during
heating mode. As the refrigerant passes through the heat exchanger, it absorbs
heat from the surrounding fluid, causing the refrigerant to change from a liquid to
a gas (or evaporate).

Air-Cooled — An air-cooled condenser is a refrigerant-to-air heat exchanger
exposed to outdoor conditions. As refrigerant passes through the coils of the
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heat exchanger, heat is rejected to outdoor air (during cooling) and absorbed
from outdoor air (during heating).

Evaporatively Cooled — An evaporatively-cooled condenser is similar to an air-
cooled condenser with the exception that during cooling, the heat exchanger is
sprayed with water, increasing the heat rejection. Heat pumps and air
conditioners equipped with evaporatively cooled condensers are typically more
efficient than their air-cooled counterparts.

Groundwater Coupled — A groundwater-coupled condenser is similar to a water-
cooled condenser except that groundwater will always be the heat source (or
sink) for the condenser. As refrigerant passes through the coils of the heat
exchanger, heat is rejected to groundwater (during cooling) and absorbed from
groundwater (during heating).

Water-Cooled — A water-cooled condenser is a refrigerant-to-water heat
exchanger. As refrigerant passes through the coils of the heat exchanger, heat is
rejected to the water (during cooling) and absorbed from the water (during
heating). Heat pumps with water-cooled condensers are typically connected to a
central circulating water loop with other water loop heat pumps.

Capacity

Select the cooling capacity range for the heat pump.

Multiple Zone Details Screen

The Multiple-Zone Details screen will only appear if you have selected Multiple-
Zone for the Zoning Category on the first screen. Select the Distribution Type,
Terminal Unit Type (if applicable), and Reheat Type (if applicable).

Note that some of the input fields are interdependent. If you select Single Duct
as the Distribution Type, you will not be able to select VAV Mixing Box or CV
Mixing Box for Terminal Unit Type, because they are only applicable to dual-duct
systems. If you select Three Duct as the Distribution Type, Terminal Unit Type
options and Reheat Type options will be disabled, because they are not
applicable to this distribution type.

When you have finished your selections on the Multiple-Zone Details screen,

click the Next button to proceed to the next screen and continue describing the
mechanical system.

Distribution Type

Single Duct — Single-duct systems are the most common types of multiple-zone
air distribution systems. A single-duct system uses a single fan to supply cool or
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warm air to zone terminal units. The zone terminal units will then modulate the
amount of supply air and sometimes reheat the supply air to meet the specific
heating or cooling requirements of the zone. Some systems will recool the
supply air, but reheating is more standard practice.

Single Fan, Dual Duct — A single-fan, dual-duct system uses a single fan to
supply air through two primary air ducts, supplying cool air and warm air. Air
from each of these ducts is then mixed in a terminal unit (VAV mixing box or CV
mixing box) and supplied to the zone as a single air stream.

Dual Fan, Dual Duct — A dual-fan, dual-duct system uses two fans to supply air
through two primary air ducts, supplying cool air and warm air. One fan serves
the warm air duct, and the other serves the cool air duct. Air from each of these
ducts is then mixed in a terminal unit (VAV mixing box or CV mixing box) and
supplied to the zone as a single air stream.

Three Duct — A three-duct system uses a single fan to supply three primary air
ducts, supplying cool air, warm air and return (or neutral) air. A three-duct
system is typically constant volume and uses CV mixing boxes to mix warm air
and return air or cool air and return air (but never warm and cool air) to meet
individual zone loads.

Terminal Unit Type

VAV Box — A standard VAV box includes a damper, a connection to the supply
air duct, and sometimes a hydronic or electric resistance reheat coil. Because
the zone thermostat calls for less cooling, the damper begins to close and
reduce the amount of supply air to the zone. The reheat colil turns on and
reheats the supply air only when the damper is at its minimum position.
Standard VAV boxes are used in both single-duct and dual-duct systems.

Fan-Powered VAV Box — A fan-powered VAV box typically consists of a fan
configured to draw air from a return air plenum , a connection to the supply air
duct, dampers to regulate the flow of air from the supply air duct and the flow of
air from the plenum to the fan, and a hydronic or electric resistance reheating
coil. There are many configurations of fan-powered VAV boxes, but there are
only two typical operation sequences: series and parallel.

In series operation, the fan operates continuously, resulting in a constant air
supply to the zone. As the zone thermostat calls for less cooling, the dampers
modulate to reduce the amount of supply air and increase the amount of plenum
air delivered to the zone. The reheat coil turns on and reheats the supply air only
when the damper is at its minimum position.

In parallel operation, the fan does not operate as long as the zone calls for
cooling. If the main supply air is reduced to a minimum and the zone still
requires heating, the fan will come on, supplying additional warmer plenum air to
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the zone. If the zone requires additional heating after the fan has come on, the
reheat coil is activated.

VAV Mixing Box — A VAV mixing box mixes air from the warm and cool air ducts
of a dual-duct system. The operation sequence of a mixing box terminal
depends on several other conditions such as if the air economizer is operating
or if the building is primarily requiring cooling or heating.

If an air economizer or the mechanical cooling plant is operating, the warm air
supply to the zones is shut off by the mixing boxes. The mixing box modulates
the flow of cool air to the zone to meet the required space conditioning. When
the cool air damper has closed to its minimum position, the mixing box will then
modulate open to allow warm air to be mixed with the cool air and simultaneous
heating and cooling begins. At some point, the mixing box may completely close
the cool air supply to the zone. Care must be taken when controlling mixing
boxes to ensure that supply air is never completely shut off to a zone. This would
prevent adequate outdoor ventilation air from being supplied to the space.

In some cases an entire building may be in heating mode, beyond what can be
met by unheated return air alone. In this case, the mixing boxes will shut off the
supply of cool air to the zones. The mixing box modulates the flow of warm air to
the zone to meet the required space conditioning. When the warm air damper
has shut to its minimum position, the mixing box will modulate open to allow cool
air to be mixed with the warm air. Like in the primary cooling mode, the warm air
damper may totally close at some point, but supply air to the zone must never be
completely shut off.

CV Mixing Box — A CV mixing box (or constant-volume mixing box) mixes
necessary amounts of cool air and warm air to maintain space conditions. The
amount of cool air or warm air will vary, but the total flow of cool and warm air
through a CV mixing box will remain constant. Except under special conditions,
the code does not allow the use of CV mixing boxes.

Reheat/Recool Coil — A reheat/recool coll is placed in a branch line to a zone of a
building and is usually controlled from a thermostat located in the space the
branch is serving. Reheat/recool coils are usually found only in single-duct VAV
systems. For example, if a reheat coll is installed in a duct, it would provide
heating to a zone if the system were in cooling mode and supplying cool air
through the distribution system. Reheat coils can be electric resistance
elements, hydronic coils, or steam coils. Recool coils are not very common and
are almost always hydronic. (COMcheck-EZ assumes recool coils are hydronic.)

Reheat Type
Electricity — When Electricity is used as the reheat type, electric resistance
heating elements are installed in the terminal units and are turned on and off by

zone thermostatic controls.
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Hydronic — Hot water coils are hydronic coils installed in the terminal units. They
are equipped with valves, which modulate the flow of hot water, and are
controlled by zone thermostatic controls.

Steam — Steam coils, used as a reheat source, are installed in terminal units.
They are equipped with valves, which modulate the flow of steam, and are
controlled by zone thermostatic controls.

Fan System Details Screen

The Fan System Details screen will only appear if you have selected Multiple-
Zone for the Zoning Category on the first screen. Check the applicable boxes
under Fan System Details. If you select Supply Fan HP >25 hp or Return Fan
HP >25 hp, select the Fan Variable Flow Control on your system. If you only
select Supply Static Pressure >3 in. water, the Fan Variable Flow Control options
are disabled.

When you have finished your selections on the Fan System Details screen, click
the Next button to proceed to the next screen in the series or click the Finish
button to accept all of the inputs and return to the Mechanical screen. You may
cancel the sequence of selections you have made at any time by pressing the
Esc (escape) key.

Fan System Details

Supply Fan HP >25 hp — The supply fan hp is the horsepower listed on the
supply fan motor nameplate. The supply fan is the fan that provides air to the
distribution ducts of the mechanical system. Select this option if the listed
horsepower is >25 hp.

Supply Static Pressure >3 in. water — Static pressure is the total amount of
pressure exerted by the supply or return air stream on the ductwork. In air
distribution and return systems, this pressure is measured in inches of water
column (in. water). Most large supply air distribution systems and multiple-zone
systems operate at static pressures exceeding 3 in. water. Occasionally, static
pressure in return air systems exceeds 3 in. water, in which case this option
should be selected.

Return Fan HP >25 hp - The return fan hp is the horsepower listed on the return
fan motor nameplate. Select this option if the return fan horsepower exceeds 25

hp.
Fan Variable Flow Control

Vane-Axial Fan w/Variable Pitch Blades — A vane axial fan resembles a
propeller. When equipped with variable pitch blades, the blades are rotated or
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twisted (thus varying the pitch of the blades) to modulate the air flow from the
fan.

Mechanical Adjustable-Speed Drive — A mechanical adjustable-speed drive uses
mechanical devices to vary the speed of the fan—and therefore vary the flow of
air—without varying the speed of the fan motor. One of the most common
approaches is to vary the diameter of the shieves in the belt-drive.

Electrical Adjustable-Speed Drive - An electrical adjustable-speed drive is an
electrical control system that will vary the speed of the fan motor, which will vary
the flow of air. The most common type of electrical adjustable speed drive is the
variable-frequency drive (VFD). A VFD is usually the most efficient approach to
varying air flow from a fan.

Other Control — Many different types of fan air flow controls are available.
Designers must use a combination of calculations, manufacturer's literature, and
actual design conditions to determine the energy performance of different fan air
flow controls.

Cooling Equipment Details Screen

The Cooling Equipment Details screen will appear if you have selected any of the
Cooling Equipment Type options on the first screen other than None.

Select the Condenser Type and the Capacity range.

When you have finished your selections on the Cooling Equipment Details
screen, click the Next button to proceed to the next screen in the series, or click
the Finish button (if not grayed out) to accept all of the inputs and return to the
Mechanical screen. You may cancel the sequence of selections you have made
at any time by pressing the Esc (escape) key.

Condenser Type

The condenser of an air conditioner is where refrigerant rejects heat absorbed
during the process of cooling indoor spaces. As the refrigerant passes through
the heat exchanger, it rejects heat to the surrounding fluid, usually air or water.

Air-Cooled — An air-cooled condenser is a refrigerant-to-air heat exchanger
exposed to outdoor conditions. As refrigerant passes through the coils of the
heat exchanger, heat is rejected to outdoor air (during cooling) and absorbed
from outdoor air (during heating).

Evaporatively Cooled — An evaporatively-cooled condenser is similar to an air-
cooled condenser with the exception that during cooling, the heat exchanger is
sprayed with water, increasing heat rejection. Heat pumps and air conditioners
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equipped with evaporatively-cooled condensers are typically more efficient than
their air-cooled counterparts.

Water-Cooled — A water-cooled condenser is a refrigerant-to-water heat
exchanger. As refrigerant passes through the coils of the heat exchanger, heat is
rejected to the water (during cooling) and absorbed from the water (during
heating). Heat pumps with water-cooled condensers are typically connected to a
central circulating water loop with other water loop heat pumps.

Capacity

Select the cooling capacity range for the cooling equipment selected on the first
screen.

Economizer Details Screen

The Economizer Details screen will appear if the building location entered in the
Project screen is located within a climate zone requiring an air economizer. The
Economizer Details screen will not appear if:

e your building is located in climate zones 1, 2, 3b, 5a, 6b; or
« the cooling capacity for the mechanical system is <65 kBtu/h.

The Economizer Details screen will also not appear if cooling capacity for the
mechanical system is < 135 kBtu/h in climate zones 3c, 5b, 7, 13b, and 14.

Select the Economizer Type. If you do not have an economizer, select None for
the Economizer Type and choose an Economizer Exception.

The input fields have the following interdependencies:

e Air economizers are not allowed if you selected Single Fan, Dual Duct, or
Three Duct as the Distribution Type on the Multiple-Zone Details screen.
An air economizer is not allowed with these system types.

« If you selected the Water-Cooled condenser, you will not be able to select
Filtration Requirements or Open Case Refrigeration as an economizer
exception.

e You will not be able to select High Efficiency Equipment as an Economizer
Exception in climate zones 6a, 9a, 10a, 11a, 12a, 12b, 13a, 13b, 14a, 14b,
15, 16, 17, 18, or 19.

When you have finished your selections on the Cooling Equipment Details
screen, click the Finish button to accept all of the inputs and return to the
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Mechanical screen. You may cancel the sequence of selections you have made
at any time by pressing the Esc (escape) key.

Economizer Type

Air — An air economizer consists of a set of interlocked dampers on return air,
exhaust air, and outside air ducts. During favorable weather conditions, the air
economizer is controlled to use up to 100% outside air to cool the space instead
of using mechanical refrigeration.

Water — A water economizer is a system by which the supply air of a cooling
system is cooled indirectly with water that is itself cooled by heat or mass transfer
to the environment without the use of mechanical cooling. Typically, water is first
passed through a cooling tower, then through a hydronic coil in the supply air
stream.

None — Select this option if an economizer will not be installed. Selecting this
option will activate some or all of the Economizer Exception options. The High
Efficiency Equipment exception will only be activated if the building resides in a
climate zone for which the exception is allowed.

Economizer Exception

High Efficiency Equipment — In some cases, a high-efficiency air conditioner may
use no more cooling energy than an air conditioner equipped with an air
economizer that just meets the requirements. In these cases, the economizer
may be omitted. The efficiency required to take this exception will be included in
the requirements list.

Open Case Refrigeration — Air economizers can adversely affect the operation of
open case refrigeration equipment such as that used in grocery stores to display
refrigerated and frozen foods. This exception is not available if the cooling
equipment has a water-cooled condenser, where a water economizer would be
feasible.

Filtration Requirements — In some cases, unusual outdoor air pollutants
necessitate extensive filtration of outdoor air. When an air economizer is
installed, filtration equipment must be capable of purifying 100% outdoor air
supply and would be prohibitively expensive. This exception is not available if
the cooling equipment has a water-cooled condenser, where a water economizer
would be feasible.
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Plant Screen

The Plant button displays a screen that enables you to identify key
characteristics of the plant equipment in your building. The term, "Plant," refers
to primary HVAC system components, including boilers, chillers, cooling towers,
and pumps; not secondary HVAC system components such as fans, terminal
boxes, radiators, coils, and package HVAC equipment.

The Plant screen allows you to describe the features of the building’s plant(s) in
sufficient detail to exclude requirements that do not apply to your building. The
resulting simplification helps in designing the building to comply with the code
and in code enforcement.

Round buttons (radio buttons) permit only one selection from each group.

Where multiple different HYAC plant components are present within the building,
you may select the Plant button multiple times to enter more than one
component. Where multiple identical (or nearly identical) plants are present,
describe them once and use the Quantity field to indicate the number present.

Plant Equipment Details Screen

New York: When New York is the selected code, an additional check box Two-
pipe Changeover System is an option.

The Plant Equipment Details screen allows you to describe your central heating
plant or central cooling plant. To enter a boiler, select a Boiler Type, Heating
Capacity Range, and Boiler Fuel. To enter a chiller or condensing unit, select a
Cooling Plant Type, Condenser Type, and Cooling Capacity Range. If you have
a water loop heat pump system served by the central plant (boiler, chiller, or
cooling tower), you must check the Water Loop Heat Pump System checkbox.

If you have selected a water loop heat pump system, water-cooled chiller or
water-cooled condensing unit, you are required to move to the second Plant
Equipment Details screen to enter details regarding the chiller type and/or heat
rejection equipment type.

When you have finished your selections on the Cooling Equipment Details
screen, click the Finish button to accept all of the inputs and return to the
Mechanical screen. You may cancel your selections by pressing the Esc
(escape) key.

Boiler Type

Hot Water — Select this option if the central boiler is a hot water boiler.
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Steam — Select this option if the central boiler is a steam boiler.

None — Select this option if you are describing a cooling plant instead of a central
boiler.

Boiler Fuel

Gas — Select Gas if the boiler uses natural gas or propane.

Oil — Select Oil if the boiler uses new heating oil that has not been recycled or re-
refined.

Residual Oil — Residual oil is fuel oil that remains after the removal of valuable
distillates (such as gasoline) from petroleum and is used most often in industrial
applications.

Heating Capacity Range
Select the heating capacity range for the boiler.

Cooling Plant Type

Condensing Unit — A condensing unit is the refrigeration system component that
includes the refrigerant compressor and the condenser. Refrigerant lines are
installed between the condensing unit and a refrigerant-to-water heat exchanger
(creating a field-fabricated water chiller) or to a DX coil (creating a field-fabricated
DX system).

Water Chiller — A water chiller is a self-contained piece of cooling equipment
including, at a minimum, a refrigerant-to-water heat exchanger and a refrigeration
compressor. Water is cooled in the refrigerant-to-water heat exchanger and
piped to air handlers used for air conditioning throughout a building. Most water
chillers include a water-cooled, air-cooled, or evaporatively-cooled condenser;
however, some water chillers are manufactured without condensers.

Cooling Capacity Range

Select the cooling capacity range for the condensing unit or chiller. Ranges for
condensing units are given in kBtu/h. Ranges for chillers are given in tons.

Water Loop Heat Pump System

A heating and cooling system that places a water-source heat pump in each
building zone conditioned by the system. A recirculating piping system connects
the heat pumps, and the circulating water provides both the source for heat
addition or the sink for heat removal from each zone. A central heat source
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(typically a boiler) and heat rejection device are typically attached to the water
loop for use as needed by the building.

Condenser Type

The condenser of an air conditioner is where refrigerant rejects heat absorbed
during the process of cooling indoor spaces. As the refrigerant passes through
the heat exchanger it rejects heat to the surrounding fluid, usually air or water. If
the equipment is a heat pump, the condenser becomes an evaporator during
heating mode. As the refrigerant passes through the heat exchanger, it absorbs
heat from the surrounding fluid, causing the refrigerant to change from a liquid to
a gas (or evaporate).

Chiller Type

Chiller Type refers to the design of water chiller being used in the building.
Options are Centrifugal-Standard, Centrifugal-Non-Standard, Rotary Screw or
Scroll, Reciprocating, Single Effect Absorption, Double Effect Absorption, Indirect
Fired, or Double Effect Absorption, Direct Fired. Centrifugal chillers refer to
electrically-driven centrifugal water chillers. Centrifugal-Standard refers to
centrifugal water chillers which are designed for, and tested at, ARI 550 standard
rating conditions. Centrifugal-Non-Standard refers to chillers which cannot be
tested at ARI Standard 550 test conditions.

Selection of Centrifugal-Non-Standard as the chiller type requires the user to
enter the Leaving Chilled Water Temperature, Entering Condenser Water
Temperature, and Condenser Flow Rate for which the chiller was designed, and
the required COP at these conditions will be provided in the final report. If these
design operating conditions cannot be found in the input screen, there are no
efficiency requirements.

Rotary Screw and Scroll refer to two separate common designs of rotary-
machine-based, electrically-driven positive displacement water chillers.
Reciprocating refers to electrically-driven reciprocating machine-based, positive
displacement water chillers. Note there are no 90.1-1999 requirements for
engine driven chiller performance.

Absorption chillers are heat driven, rather than compression driven, chiller
designs, and rely on the absorption/desorption of a refrigerant (typically water) in
a absorbent solution. 90.1-1999 recognizes three distinct types of absorption
chillers. Single effect absorption chillers (all designs), double-effect absorption
chillers, direct-fired, and double-effect absorption chillers, indirect-fired. The
terms single-effect, double-effect, direct-fired, and indirect-fired are common
industry terminology and are defined below.
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« Direct-Fired. Heat energy input to direct absorption units is through direct
combustion of a fossil fuel.

e Indirect-Fired. Heat energy input to indirect fired absorption units is
through steam or hot water circulated to the absorption chiller.

e Single-Effect absorption chillers employ 1-step reconcentration of the
absorbent in the generator.

o Double-effect absorption chillers employ 2-step reconcentration of the
absorbent in the generator.

Heat Rejection Device

Selection of a water cooled chiller requires that the user also select a “heat
rejection device”. Options presented are Air-Cooled Condenser, Centrifugal Fan
Cooling Tower, Propeller Fan Cooling Tower. Air-cooled condensers cool the
condenser water from the chiller by moving air past a water-to-air heat
exchanger. Cooling towers perform the same task but rely primarily on
evaporative cooling of water circulated through the tower. Centrifugal cooling
towers refer to cooling towers using centrifugal fan designs, propeller fan cooling
towers use propeller type fans.

Note, chillers that have the heat rejection device built into the chiller package
(and which do not require a separate “heat rejection device” be installed) are
referred to as “air-cooled” or “evaporatively-cooled” chillers as appropriate and
the chiller performance rating includes the performance of the internal heat
rejection equipment. No separate heat-rejection device performance need be
met.
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Service Water Heating Screen

The Water Heating button displays a screen that enables you to select two
characteristics of the service water heating system(s) in your building. The
selection (or deselection) of the two checkboxes on the Service Water Heating
Details screen determines which water heating requirements apply to your
building.

Where multiple different water heating systems are present within the building,
you may select the Water Heating button multiple times to enter more than one
system. Where multiple identical (or nearly identical) systems are present,
describe them once and use the Quantity field to indicate the number present.

Service Water Heating Details Screen

The Service Water Heating Details screen allows you to provide basic
information about your service water heating system. Checkboxes are provided
for indicating whether or not your system has a circulation pump and/or if heat
trace tape is installed.

When you have finished your selections on the Service Water Heating Details
screen, click the Finish button to accept all of the inputs and return to the
Mechanical screen. You may cancel your selections by pressing the Esc
(escape) key.

System Details

System Has a Circulation Pump - A circulation pump is used in a service water
heating system served by a continuous water loop. The circulation pump is
controlled to circulate hot water from the water heating equipment as necessary
to maintain a certain hot water temperature at all times in the circulation loop.

Heat Trace Tape Installed in the System - Heat trace tape is tape with embedded
electric resistance heating elements. Heat trace tape is adhered to hot water
piping. It is energized as necessary to deliver hot water at the desired
temperature.
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Building Use Types

The Whole Building types and the Area Categories available in the software are
defined below.

Whole Building Types

Assembly — A building or structure for the gathering together of persons, such
as auditoriums, churches, dance halls, gymnasiums, theaters, museums,
passenger depots, sports facilities, and public assembly halls. (This building type
cannot be used to demonstrate lighting compliance and will be disabled if the
Envelope and/or Mechanical Compliance Only checkbox is not selected.)

Exercise Center — A building or structure used for recreational activities
involving physical exertion designed to promote physical fitness and well-being.

Grocery Store — A building or structure that has as its primary purpose the sale
of foodstuffs requiring additional preparation prior to consumption.

Hotel/Motel — A building or structure for transient occupancy, such as resorts,
hotels, motels, barracks, or dormitories.

Library — A building or structure in which literary and artistic materials, such as
books, periodicals, and audiovisuals, are kept for reading, reference, and loan.

Medical/Clinical Care — A building or structure for the purpose of providing
medical treatment, confinement or care, and sleeping facilities such as hospitals,
sanitariums, clinics, orphanages, nursing homes, mental institutions, and
reformatories.

Multifamily — A building or structure containing three or more dwelling units.
(This building type cannot be used to demonstrate lighting compliance and will
be disabled if the Envelope and/or Mechanical Compliance Only checkbox is not
selected.)

Museum — A building used for the display and preservation of objects of artistic,
scientific, or cultural interest.

Office — A building or structure for office, professional, or service type
transactions such as medical offices, banks, libraries, and government office
buildings.

Restaurant — A building or structure for the preparation and consumption of food

or drink, including coffee shops, cafeterias, bars, and fast food and leisure
restaurants.
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Religious Worship — A building for worship, religious services, and associated
social and educational functions.

Retail Sales/Wholesale Showroom — A building or structure for the display and
sale of merchandise such as shopping malls, food markets, auto dealerships,
department stores, and specialty shops.

School — A building or structure for the purpose of instruction, such as schools,
colleges, universities, and academies.

Storage Commercial/Industrial — A building or structure for storage, such as
aircraft hangars, garages, warehouses, storage buildings, and freight depots.

Theater — Motion Picture — An assembly room, hall, or building with tiers of
rising seats or steps for the showing of motion pictures.

Theater — Performance — An assembly room, hall, or building with tiers of rising
seats or steps for the viewing of dramatic performances, lectures, musical
events, and similar live performances.

Others — A building or structure whose intended use is currently not known or
does not match any of the above categories.

Area Use Categories

The following area categories are listed in the software. For area categories
other than those given, select categories with similar areas and/or activities.

Auditorium — An area with fixed seats used for public meetings or gatherings not
specifically for the viewing of dramatic performances.

Bank/Financial Institution — An area for conducting financial transactions
including the custody, loan, exchange, or issue of money, for the extension of
credit, and for facilitating the transmission of funds.

Classroom/Lecture Hall — An area where classes meet.

Convention/Conference/Meeting Center — An area used for meetings,
conventions, and multiple purposes, including dramatic performances, that has
neither fixed seating nor fixed staging.

Corridor/Restroom/Support — Corridor: an area used as a passageway to

access compartments or rooms. Restroom: An area providing personal facilities
such as toilets and washbasins. Support: An area used as a passageway, utility
room, storage space, or other use associated with the building's primary function.
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Dining — An area in a restaurant or hotel/motel (other than guest rooms) where
meals served to the customers are consumed.

Exercise Center — A building or area used for recreational activities involving
physical exertion designed to promote physical fitness and well-being.

Exhibition Hall — An area used for exhibition that has neither fixed seating nor
fixed staging.

Grocery Store — An area of that building that has as its primary purpose the sale
of foodstuffs requiring additional preparation prior to consumption.

Gymnasium Playing Surface — An area of a building for organized athletic
games such as basketball, volleyball, racquetball, and tennis.

Hotel Function — An area such as a hotel ballroom, meeting room, exhibit hall,
or conference room, together with prefunction area and other spaces ancillary to
its function.

Hotel/Motel Guest Room — A room or suite of rooms in a building for transient
occupancy (such as a resort, hotel, motel, barracks, or dormitory), including living
and sleeping areas, private bathrooms, and kitchenettes. (Note that hotel/motel
guest rooms are exempt from lighting requirements but are included in the area
category list for consistency and for use in determining internal loads for
envelope compliance.)

Industrial Work <20 ft ceiling height — An area of a building in which a
manufacturing operation, craft, or art is performed having a ceiling height less
than 20 ft above the floor.

Industrial Work >= 20 ft ceiling height — An area of a building in which a
manufacturing operation, craft, or art is performed having a ceiling height 20 or
more feet above the floor.

Kitchen — An area containing facilities for cooking and food preparation.

Library — A building or area in which literary and artistic materials, such as
books, periodicals, and audiovisuals, are kept for reading, reference, and loan.

Lobby — Hotel — An area in a hotel/motel between the main entrance and the
front desk, including waiting and seating areas, and other spaces encompassing
the activities normal to a hotel lobby function.

Lobby — Other — An area located directly inside the main entrance of a building
and includes the reception area, sitting areas, and public areas.

Mall/Arcade/Atrium — An area used as a public passageway or concourse that
provides access to rows of stores or shops.
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Medical/Clinical Care — An area of a building where medical treatment is
provided, such as hospitals, sanitariums, clinics, orphanages, nursing homes,
mental institutions, and reformatories.

Multifamily Living Unit — A private room or group of rooms for nontransient
residential living that occur within a building or structure containing three or more
dwelling units. (Note that multifamily living units are exempt from lighting
requirements but are included in the area category list for consistency and for
use in determining internal loads for envelope compliance.)

Museum — An area of a building used for the display or preservation of objects of
artistic, scientific, or cultural interest.

Office — An area of a building for office, professional, or service-type transactions
such as medical offices, banks, libraries, and government office buildings.

Religious Worship — An area of a building for worship or religious services.

Restaurant — An area of a building for the preparation and consumption of food
or drink including coffee shops, cafeterias, bars, and fast food and leisure
restaurants.

Retail Sales/Wholesale Showroom — An area of a building in which the primary
activity is the sale of merchandise or the display of samples of merchandise.

Storage — Commercial/Industrial — A building or area used for storing items.

Theater — Motion Picture — A building or area with tiers of rising seats or steps
for the showing of motion pictures.

Theater — Performance — A building or area with tiers of rising seats or steps for
the viewing of dramatic performances, lectures, musical events, and similar live
performances.

Others — A building or area whose intended use is currently not known or does
not match any of the above types.
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Glossary

A

AAMA: Architectural Aluminum Manufacturers Association

addition: Newly conditioned spaces or previously unconditioned spaces after
heating or cooling equipment has been installed

Air Economizer Systems: Ducting arrangements and automatic control systems
that allow a cooling supply fan system to supply outdoor (outside) air to
reduce or eliminate the need for mechanical refrigeration during mild or
cold weather

ASHRAE/IES Standard 90.1-1989: The American Society of Heating,
Refrigerating and Air-Conditioning Engineers/lllumination Engineering
Society Standard 90.1-1989

ASHRAE/IESNA Standard 90.1-1999: The American Society of Heating,
Refrigerating and Air-Conditioning Engineers/lllumination Engineering
Society Standard 90.1-1999

ASHRAE/IESNA Standard 90.1-2001: The American Society of Heating,
Refrigerating and Air-Conditioning Engineers/lllumination Engineering
Society Standard 90.1-2001

automatic time-switch controls: Controls that automatically switch lights or
equipment on and off

automatically operated control damper: A damper which automatically opens
and closes

B

ballast: A device used to operate fluorescent and HID lamps. The ballast
provides the necessary starting voltage, while limiting and regulating the
lamp current during operation

below-grade wall: Portions of the wall below grade

boiler: A pressurized system in which water is vaporized to steam by heat
transferred from a source of higher temperature, usually the products of
combustion from burning fuels. Steam thus generated may be used
directly as a heating medium, or as the working fluid in a prime mover to
convert thermal energy to mechanical work, which in turn may be
converted to electrical energy

building envelope: The elements of a building that enclose conditioned spaces
through which thermal energy may be transferred to or from the exterior or
to or from unconditioned spaces
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C

cavity insulation: Insulation installed between structural members, including all
blown insulation

ceiling: Those portions of the building envelope, including all opaque surfaces,
fenestration, doors, and hatches, that are above conditioned space and
are horizontal or titled at less than 60 degrees from horizontal

circulating water heater: Hot water continuously circulates through the
distribution system

circulation pumps: Pumps that are used to keep hot water circulating through
the distribution system

commercial building: Includes but is not limited to occupancies for assembly,
business, education, institutions, merchants, and storage

compact fluorescents: Small fluorescent lamps that are often used as an
alternative to incandescent lighting. The lamp life is about 10 times longer
than incandescent lamps and is 3-4 times more efficacious

concrete masonry unit walls: Concrete masonry unit walls may be insulated by
filling the empty core with perlite, vermiculite, or some other insulative
material. In some cases, even with filled cores, these wall types require
additional insulation

conditioned floor area: The horizontal projection of that portion of interior space
which is contained within exterior walls and which is conditioned directly or
indirectly by an energy-using system

conditioned space: A cooled or heated space, or an indirectly conditioned
space

connected lighting load: The sum of all non-exempt interior lighting power,
measured in watts

continuous insulation: Insulation that runs continuously over structural
members and is free of significant thermal bridging, such as rigid foam
insulation

cooled space: An enclosed space within a building that is cooled by a cooling
system whose capacity (a) exceeds 6 Btu per hour per square foot or (b)
is capable of maintaining a space dry-bulb temperature of 90 degrees F or
less at design cooling conditions

D
domestic water heating system: DHW systems may be circulating or non-
circulating
E
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economizer: A ducting arrangement and automatic control system that allow a
cooling supply fan system to supply outdoor air to reduce or eliminate the
need for mechanical refrigeration during mild or cold weather

EER: The energy efficiency ratio is the ratio of net equipment cooling capacity in
Btu/h to total rate of electric input in watts under designated operating
conditions. When consistent units are used, this ratio becomes equal to
coefficient of performance

efficacy: A metric used to compare light output to energy consumption. Efficacy
is measured in lumens per watt. Efficacy is similar to efficiency, but is
expressed in dissimilar units. For example, if a 100-watt source produces
9000 lumens, then the efficacy is 90 lumens per watt

electronic high-frequency ballasts: Electronic ballasts improve fluorescent
system efficacy by converting the standard 60 Hz input frequency to a
higher frequency, usually 25,000 to 40,000 Hz. Lights operating on these
frequencies produce about the same amount of light, while consuming up
to 30% less power than a standard magnetic ballast

enclosed space: A volume substantially surrounded by solid surfaces such as
walls, floors, roofs, and openable devices such as doors and operable
windows. Spaces not meeting these criteria for enclosure are considered
to be exterior to the building for purposes of determining envelope
requirements. For example, most parking garages do not qualify as
enclosed space

envelope components: The building assemblies that provide a barrier between
conditioned space and unconditioned space. This includes the floors,
walls, and ceiling/roof assemblies of the building

F

fan coil: A fan-coil terminal is essentially a small air-handling unit which serves a
single space without a ducted distribution system. One or more
independent terminals are typically located in each room connected to a
supply of hot and/or chilled water. At each terminal, a fan in the unit draws
room air (sometimes mixed with outside air) through a filter and blows it
across a coil of hot water or chilled water and back into the room

fenestration: The terms "fenestration”, "window", and "glazing" are often used
interchangeably. However, fenestration refers to the design and position of
windows, doors and other structural openings in a building

floor: A horizontal exterior partition, or a horizontal demising partition, under
conditioned space which separates conditioned space from unconditioned
space

fluorescent lamps: A light source consisting of a tube filled with argon, along
with krypton or other inert gas. When electrical current is applied, the
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resulting arc emits ultraviolet radiation that excites the phosphors inside
the lamp wall, causing them to radiate visible light

fuel-fired furnace: A self-contained, indirect-fired furnace that supplies heated
air through ducts to spaces that require it

G

glazing: The terms "fenestration”, "window", and "glazing" are often used
interchangeably. However, glazing is the transparent component of glass
or plastic windows, doors, clerestories, or skylights

glazing U-factor: Based on the interior-surface area of the entire assembly,
including glazing, sash, curbing, and other framing elements. Center-of-
glass U-factors cannot be used

gross wall area: Includes the opaque area of all above-grade exterior walls
enclosing conditioned spaces (including above-grade portions of below-
grade wall assemblies but excluding walls separating conditioned from
unconditioned space); the area of the band joist and subfloor between
floors; and the area of all doors and windows

gross window area: Includes the rough-opening area of the window, not just the
transparent-glass area

H

heat pump: One or more factory-made assemblies which include an indoor
conditioning coil, compressor(s) and outdoor coil or refrigerant-to-water
heat exchanger, including means to provide both heating and cooling
functions

heat traps: Devices or piping arrangements that effectively restrict the natural
tendency of hot water to rise in vertical pipes during standby periods.
Examples are the U-shaped arrangement of elbows or a 360-degree loop
of tubing

heated space: An enclosed space within a building that is heated by a heating
system whose output capacity (a) exceeds 10 Btu per hour per square
foot and (b) is capable of maintaining a space dry-bulb temperature of 50
degrees F or more at design heating conditions. (90.1-1999 definition: An
enclosed space within a building that is heated by a heating system whose
output capacity relative to the floor area is greater than or equal to the
criteria in Table 3-2 in the ASHRAE/IESNA Standard 90.1-1999

HID: High intensity discharge. Generic term describing mercury vapor, metal
halide, high pressure sodium, and (informally) low pressure sodium light
sources and luminaires

high-pressure sodium lamps: High-intensity discharge (HID) lamps whose light
is produced by radiation from sodium vapor (and mercury)
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high-rise residential buildings: Hotels, motels, apartments, condominiums,
dormitories, and other residential-type facilities that provide complete
housekeeping or transient living quarters and are over three stories in
height above grade. Hotels, motels, and other buildings with itinerant
occupancies are covered by the "commercial" code regardless of height

HVAC: Heating, ventilating, and air-conditioning

HVAC system: The equipment, distribution network, and terminals that provide
either collectively or individually the processes of heating, ventilating, or
air conditioning to a building

ICAA: Insulation Contractors Association of America
ICC: International Code Council
IMC: International Mechanical Code

indirectly conditioned space: An enclosed space within a building that is not a
heated or cooled space, whose area-weighted heat transfer coefficient to
heated or cooled spaces exceeds that to the outdoors or to unconditioned
spaces; or through which air from heated or cooled spaces is transferred
at a rate exceeding three air changes per hour. (Also see Heated Space,
Cooled Space, and Unconditioned Space.)

insulation R-values: R-values are used to rate insulation and are a
measurement of the insulation's resistance to heat flow. The higher the R-
value, the better the insulation

integrated-control economizers: Allows the cooling load of a building or space
to be partially met by supplying outside air while the rest of the load is met
by the refrigeration equipment within an HVAC system. Field- and factory-
installed economizers supplied by major equipment manufacturers include
integrated controls

interior-lighting controls: Offer the ability for systems to be turned on and off
either manually or automatically and include switches, time clocks,
occupancy sensors and other devices that regulate a lighting system

interior lighting power limits: The maximum total wattage for a building or
space that can be installed to meet the provisions of the energy code

L

longitudinal seam: A duct seam that is parallel to the direction of air flow

luminaire: A complete lighting unit consisting of a lamp or lamps, along with the
parts designed to distribute the light, hold the lamps, and connect the
lamps to a power source. Also called a fixture
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M

mechanical system: The system and equipment used to provide heating,
ventilating, and air conditioning functions as well as additional functions
not related to space conditioning, such as, but not limited to, freeze
protection in fire protection systems and water heating

metal building walls and roofs: Special attention to the design and construction
of metal buildings is required to ensure these buildings meet the
COMcheck-EZ requirements. Two key elements exist in metal buildings
that are not found in other building classes - thermally broken connections
between the purlin and metal roof sheet and compression of insulation
behind wall girths and roof purlins. COMcheck-EZ includes requirements
for metal building walls and roofs. These requirements are specified in the
"Walls Framed - Metal Framing" category and in the "Roofs Metal Purlin”
category in the Prescriptive Packages. There are two classes of metal
building roofs. One class uses traditional techniques that drape the
insulation over the purlin and fasten the metal roof sheets through the
insulation directly to the purlin. The second class requires that a thermal
block be placed between the metal roof sheet and purlin. A thermal block
consists of foam blocks or other materials/techniques that prevent heat
from migrating from the purlin directly to the metal roof sheet. Compressed
fiberglass batt insulation does not qualify as a thermal block

metal halide lamps: A type of high intensity discharge (HID) lamp in which most
of the light is produced by radiation of metal halide and mercury vapors in
the arc tube. Available in clear and phosphor-coated lamps

O

occupancy type: The type of activity occurring within a building

occupant-sensing device: A device that detects the presence or absence of
people within an area and causes any combination of lighting, equipment,
or appliances to be adjusted accordingly

P

packaged boiler: A self-contained unit that generally requires little maintenance

packaged terminal air conditioner: A factory-selected wall sleeve and separate
unencased combination of heating and cooling components, assemblies,
or sections (intended for mounting through the wall to serve a single room
or zone). It includes heating capability by hot water, steam, or electricity

packaged terminal heat pump: A packaged terminal air conditioner capable of
using the refrigeration system in a reverse cycle or heat pump mode to
provide heat
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perm rating: The amount of water vapor that passes through an area in a certain
period of time

permanently wired luminaires: Light fixtures physically attached to a surface
(e.g. ceiling or wall) using a permanent mounting system and wired
directly to a power source. Examples include fluorescent fixtures located
in a ceiling grid and wall sconces

photocell: A light sensing device used to control luminaires and dimmers in
response to detected light levels

plenum: An enclosure that is part of the air-handling system and is distinguished
by having a very low air velocity. A plenum often is formed in part or in
total by portions of the building

projection factor: The exterior horizontal shading projection depth divided by
the sum of the height of the fenestration and the distance from the top of
the fenestration to the bottom of the external shading projection in units
consistent with the projection depth

R

R-value: Thermal resistance to heat flow. A larger number means less heat flow

residential buildings: Detached one and two family dwellings. A building
containing multiple (i.e., three or more) dwelling units where the occupants
are primarily permanent in nature, such as townhouses, row houses,
apartment houses, convents, monasteries, rectories, fraternities and
sororities, dormitories, and rooming houses, all of which are three stories
or less in height above grade

roof: Those portions of the building envelope, including all opaque surfaces,
fenestration, doors, and hatches, that are above conditioned space and
are horizontal or tilted at less than 60 degrees from horizontal

S

semiheated space: 90.1-1999 only: An enclosed space within a building that is
heated by a heating system whose output capacity is greater than or equal
to 3.4 Btu/h ft2 of floor area but is not a conditioned space

service water heating: The supply of hot water for purposes other than comfort
heating and process requirements

shading coefficient: The ratio of solar heat gain through fenestration, with or
without integral shading devices, to that occurring through unshaded 1/8-
in.-thick double-strength glass

SHGC: solar heat gain coefficient

single-zone, unitary HVAC systems: Unitary HVAC systems that serve a single
zone. Single zone systems can provide either heating or cooling, but
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provide supply air at the same volume and temperature to the entire zone
which they serve

skylight: Glazing that is horizontal or tilted less than 60 degrees from horizontal

solar heat gain coefficient: The glazing's effectiveness in rejecting solar heat
gain. SHGC is part of a system for rating window performance used by the
National Fenestration Rating Council (NFRC). SHGC is gradually
replacing shading coefficient (SC) in product literature and design
standards

split system: Split-system HVAC equipment has the indoor and outdoor coils
within separate cabinets. For a cooling only system, the outdoor cabinet
would contain the condenser coil and the indoor cabinet would contain the
evaporator coil

structural masonry wall: (not a wall type in 90.1-1999) A wall construction
category used with masonry, precast and poured-in-place concrete, and
concrete masonry units. You can select from among six specific types of
masonry wall constructions by clicking the Ext. Wall button and selecting
Structural Masonry Wall or by clicking the Basement button

switched receptacles: The ability to turn power on and off to an electrical outlet
by using a control switch

T

tandem wiring: Pairs of luminaires operating with lamps in each luminaire
powered from a single ballast contained in one of the luminaires. This
reduces labor, materials, and energy costs

temperature reset controls: Controls that automatically reset supply water
temperatures by representative building loads (including return water
temperature) or by outside air temperature

thermostat: An automatic control device responsive to temperature

thermostat set back: Usually done at night to reduce the amount of conditioning
provided at night by allowing the interior temperature to drift naturally to a
marginal temperature during the night and then to recondition it to normal
conditions in the morning

transverse seam: All duct seams other than the longitudinal seam (which runs
parallel to the direction of air flow)

U

U-factor: The amount of heat in Btu that flows each hour through one square
foot, when there is a 1 degree F temperature difference across the
surface. The smaller the number, the less heat flow

UL 181A: A test procedure for tapes and mastics used to seal ductwork
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UL 181B: A test procedure for tapes and mastics used to seal ductwork

unconditioned space: An enclosed space within a building that is not a
conditioned space

unitary-packaged: Each package is a standalone system which provides all of
the heating and cooling requirements for the area of the building which it
serves

V

vapor retarder: A component that retards water vapor diffusion, but does not
totally prevent its transmission. Vapor retarder material is usually a thin
sheet or coating. However, a construction of several materials, some
perhaps of substantial thickness, could also constitute a vapor retarder
system

variable-air volume (VAV) system: HVAC system that controls the dry-bulb
temperature within a space by varying the volume of heated or cooled
supply air to the space

variable-frequency drive: Changes the speed of the motor by changing the
voltage and frequency of the electricity supplied to the motor based upon
system requirements

ventilated mechanically: The process of supplying or removing air by
mechanical means to or from any space. Such air may or may not have
been conditioned

ventilated naturally: The process of supplying or removing air by natural means
to or from any space

visible light transmittance: The fraction of solar radiation in the visible light
spectrum that passes through the fenestration

W

wall: Opaque portion of the building envelope
water heating: The process or system used to heat service water

water temperature reset: Temperature shall be reset by at least 25% of the
design supply-to-return water temperature difference

WDMA: Window and Door Manufacturers Association

window: The terms "fenestration", "window", and "glazing" are often used
interchangeably. However, window actually describes a system of several
components. Window is the term given to an entire assembly comprised of
the sash, glazing, and frame

window wall ratio: The gross window area divided by the gross wall area
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zone: A space or group of spaces within a building with any combination of
heating, cooling, or lighting requirements sufficiently similar so that desired
conditions can be maintained throughout by a single controlling device
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